HELP.LEWMLSR

Interface Between the WMS
and External Systems

Release R/3 Enterprise 4.7

SAP Online Help

07.10.2002

Copyright
© Copyright 2002 SAP AG. All rights reserved.
No part of this publication may be reproduced or transmitted in any form or for any purpose
without
the express permission of SAP AG. The information contained herein may be changed
without prior notice.
Some software products marketed by SAP AG and its distributors contain proprietary
software components of other software vendors.
Microsoft®, WINDOWS®, NT®, EXCEL®, Word®, PowerPoint® and SQL Server® are
registered trademarks of Microsoft Corporation.
IBM®, DB2®, DB2 Universal Database, OS/2®, Parallel Sysplex®, MVS/ESA, AIX®, S/390®,
AS/400®, OS/390®, OS/400®, iSeries, pSeries, xSeries, zSeries, z/OS, AFP, Intelligent
Miner, WebSphere®, Netfinity®, Tivoli®, Informix and Informix® Dynamic ServerTM are
trademarks of IBM Corporation in USA and/or other countries.
ORACLE® is a registered trademark of ORACLE Corporation.
UNIX®, X/Open®, OSF/1®, and Motif® are registered trademarks of the Open Group.
Citrix®, the Citrix logo, ICA®, Program Neighborhood®, MetaFrame®, WinFrame®,
VideoFrame®, MultiWin® and other Citrix product names referenced herein are trademarks of
Citrix Systems, Inc.
HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C®, World Wide
Web Consortium, Massachusetts Institute of Technology.
JAVA® is a registered trademark of Sun Microsystems, Inc.
JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for
technology invented and implemented by Netscape.
SAP, SAP Logo, R/2, RIVA, R/3, SAP ArchiveLink, SAP Business Workflow, WebFlow,
SAP EarlyWatch, BAPI, SAPPHIRE, Management Cockpit, mySAP, mySAP.com, and other
SAP products and services mentioned herein as well as their respective logos are
trademarks or registered trademarks of SAP AG in Germany and in several other countries
all over the world. MarketSet and Enterprise Buyer are jointly owned trademarks of
SAP Markets and Commerce One. All other product and service names mentioned are the
trademarks of their respective owners.

Interface Between the WMS and External Systems

620

2

SAP Online Help

07.10.2002

Icons
Icon

Meaning
Caution
Example
Note
Recommendation
Syntax

Typographic Conventions
Type Style

Description

Example text

Words or characters that appear on the screen. These include field
names, screen titles, pushbuttons as well as menu names, paths and
options.
Cross-references to other documentation.

Example text

Emphasized words or phrases in body text, titles of graphics and tables.

EXAMPLE TEXT

Names of elements in the system. These include report names,
program names, transaction codes, table names, and individual key
words of a programming language, when surrounded by body text, for
example, SELECT and INCLUDE.

Example text

Screen output. This includes file and directory names and their paths,
messages, source code, names of variables and parameters as well as
names of installation, upgrade and database tools.

EXAMPLE TEXT

Keys on the keyboard, for example, function keys (such as F2) or the
ENTER key.

Example text

Exact user entry. These are words or characters that you enter in the
system exactly as they appear in the documentation.

<Example text>

Variable user entry. Pointed brackets indicate that you replace these
words and characters with appropriate entries.
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Interface Between the WMS and External Systems
Purpose
The Warehouse Management system (WMS) has an interface (WMS-WCU interface) with
which you can connect
• Automated warehouse systems, such as warehouse control units (WCU)
• Fork lift control systems or carousels
• Decentralized warehouse management systems
to the Warehouse Management system.

Integration
The interface allows communication between the connected systems on the basis of the socalled transactional Remote Function Call [Extern] (tRFC).
Unlike the synchronous Remote Function Call (sRFC), the system saves the data in
temporary storage before sending it to the connected system. This leads to the decoupling of
application and communication.

Features
Interface between the WMS and external systems (WMS-WCU interface)
On the basis of the WMS-WCU interface, you connect automated warehouse systems such
as warehouse control units (WCU), fork lift control systems, or carousels to the Warehouse
Management system (WMS).
For more information see Scenarios for Connecting External Systems [Seite 6] and
Description of the IDocs [Seite 31].

Mobile data entry (LE-MOB) and the SAP console
Using this interface, you can enter data decentrally, for example via barcode readers or
character-based radio frequency devices, and transfer the data to the database of your SAP
system.
For more information, see Mobile Data Entry [Extern].

Decentralized Warehouse Management system
You can interface the Warehouse Management system as a stand-alone component with the
SAP system or integrate the Warehouse Management system with any Enterprise Resource
Planning system. This means that the ERP system and the Warehouse Management system
can run on separate machines. For more information, see Decentralized Warehouse
Management [Extern].
See also:
Warehouse Management With Lean WM [Extern]
Electronic Data Interchange/IDoc Interface [Extern] (SD-EDI)
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Scenarios for Connecting External Systems
You can connect various external systems to the Warehouse Management system (WMS) via
the interface between the WMS and external systems (WMS-WCU interface). The following
scenarios give you an overview of typical ways in which this interface can be used.
External systems include on the one hand WMS-dependent warehouse systems such as
warehouse control units (WCUs) or fork lift control systems, and on the other hand systems,
which only help themselves from the warehouse, for example production control stations.

Features
The WMS-WCU interface supports the following communication processes between the
systems:
• Transferring transfer orders [Extern] from the SAP WMS to the external system
• Transferring the release of collective processes [Extern] from the SAP WMS to the
external system
• Transferring cancellation requests from the SAP WMS to the external system
•
•
•

Creating transfer orders reported by the external system in the SAP WMS
Confirming transfer orders reported as completed by the external system in the SAP
WMS
Moving storage units [Extern]

•
•

Blocking storage units or aisles
Creating transfer requirements [Extern] reported by the external system in the SAP WMS

•

Canceling transfer orders in the SAP WMS, which the external system reports as not
completed
The WMS generally takes on all of the warehouse management tasks. However, warehouse
control and execution of transportation orders are not part of the SAP WMS’s tasks.
For this reason, the external systems are always independent of the SAP system, and they
can take over not only the control of the material flow, but also other tasks such as optimizing
warehouse movements or additional control mechanisms.
The distribution of tasks between the WMS and the connected systems is in the foreground of
the scenarios. The flexibility of the WMS-WCU interface allows you to make user-defined
adjustments and enhancements. For further information, see Modification Concepts: IDoc
Inbound Processing [Seite 79] and Modification Concepts: IDoc Outbound Processing [Seite
82].

Activities
You distribute tasks between the WMS and the external system on an individual customer
basis.
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Connecting a Semi-Automated Warehouse
Purpose
In a semi-automated warehouse, you manage the warehouse with the Warehouse
Management system (WMS), while a connected external system executes the actual
warehouse movements.
The WMS executes all of the warehouse management tasks, which include:
•
•

Managing the material stocks and the storage bins
Triggering warehouse movements (stock removal, putaway, stock transfers and posting
changes)
• Determining the storage bins for warehouse movements based on fixed putaway and
stock removal strategies
• Carrying out the inventory
To optimize procedures in the warehouse, you implement an external system alongside the
WMS in order to:
•
•
•

Connect fork lift systems
Control automatic conveyors or conveyor equipment
Allow picking without any documents, using RF devices

•

Control the material flow

The following describes two variations of the scenario:
•

The WMS does not transfer any data via the WMS-WCU interface to the
external system. The interface is only used to confirm execution of the
warehouse movements to the WMS.

•

The WMS-WCU interface can be used to transfer any planned
warehouse movements to the external system, and to report back to the
WMS that warehouse movements have been executed.

Prerequisites
You have set up the interface between the WMS and the external system in the Customizing
for Warehouse Management under Interfaces → External Systems → Configure Warehouse
Management [Extern].
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Process Flow
Confirmation via the WMS-WCU interface: Putaway
SAP WMS

External System

Triggers
Goods Movements
Creates TOs
for Putaway
Print TO
for Putaway

Scan Pallet Note
into External System
Executes
Warehouse Movements
Reports Back
Goods Movements
WCU Interface
WMTOCO

Confirms
Reported TOs

1. The WMS creates transfer orders (TOs) for the goods movements.
2. You print the transfer order to use as a pallet note.
The destination storage bin for putaway is printed on the pallet note in the form of a
barcode.
3. You transport the pallet to the automatic conveyor.
4. You scan in the barcode with the destination storage bin at the automatic conveyor.
5. The automatic conveyor carries the pallet to the storage bin and puts it away.
6. If, according to the Customizing settings in the WMS, the TO transferred by the WMS has
to be reported back, the external systems reports back to the WMS that the warehouse
movements for the TO have been executed via message type WMTOCO.
The external system constructs the transfer order data in the form of an IDoc in the
fork lift control system and sends the IDoc to the WMS.
7. The WMS confirms the transfer order on the basis of the data that was transferred using
message type WMTOCO.
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Confirmation via the WMS-WCU interface: Stock removal
SAP WMS

External System

Triggers
Warehouse Movements
Creates TOs
for Stock Removal
Print out TO
for Stock Removal

Scan into
External System
Executes
Warehouse Movements
Reports Back
Goods Movements
WCU Interface
WMOCO

Confirms
Reported TOs

1. The WMS creates transfer orders (TOs) for the stock removal.
2. You print the transfer orders to use as pick lists.
The source storage bin for stock removal is printed on the pick list in the form of a
barcode.
3. You scan the barcode with the source storage bins into the automatic conveyor.
4. The automatic conveyor removes the pallet from storage.
If picking takes place directly at the storage bin, the automatic conveyor goes directly
to the relevant source storage bin when you scan in the stock removal slip.
5. If, according to the Customizing settings in the WMS, the transfer order transferred by the
WMS has to be reported back, the external systems reports back to the WMS via
message type WMTOCO that the warehouse movements for the TO have been
executed.
The external system constructs the transfer order data in the form of an IDoc in the
fork lift control system and sends the IDoc to the WMS.
6. The WMS confirms the transfer order on the basis of the data that was transferred using
message type WMTOCO.
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Transferring transfer orders for warehouse movements to the external
system
SAP WMS

External System

Triggers
Warehouse Movements
Creates TOs for the
Warehouse Movements
Transfers TOs to
External System
WCU Interface
WMTORD
Optimizes
Warehouse Movements
Executes
Warehouse Movements
Controls any
Warehouse Movements
Reports Back
Warehouse Movements
WCU Interface
WMTOCO
Confirms
Reported TOs

8. The WMS creates transfer orders (TOs) for the goods movements.
9. The WMS transfers the transfer orders to the external system using the message type
WMTORD.
10. The external system executes the goods movements in the warehouse on the basis of
the transferred data. The fork lift control system monitors all of the movements.
11. If you have defined in Customizing, that the TO transferred by the WMS has to be
reported back to the WMS, the external system reports back to the WMS via message
type WMTOCO that the warehouse movements for the TO have been executed.
The external system constructs the transfer order data in the form of an IDoc in the
fork lift control system and sends the IDoc to the WMS.
12. The WMS confirms the transfer order on the basis of the data that was transferred using
message type WMTOCO.

Triggering warehouse movements manually via the external system
1. If you trigger goods movements manually (for example due to a stock transfer within a
warehouse when you group together remaining quantities in order to make space), you
enter the warehouse movements in the fork lift system.
2. The fork lift system reports the warehouse movements that have been executed to the
WMS via the message type WMTOCO.
The external system constructs the transfer order data in the form of an IDoc in the
fork lift control system and sends the IDoc to the WMS.
3. The WMS creates a transfer order on the basis of the data transferred using message
type WMTOCO, and updates the stock data in the Warehouse Management system.
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Connecting a Fully Automated Warehouse
Purpose
If you want to implement the Warehouse Management system (WMS) in a fully automated
warehouse, take the warehouse structure and the warehouse automation functions into
account when deciding how best to distribute the warehouse management tasks between the
WMS and the external system.
The WMS takes on the most important warehouse management tasks, even in a fully
automated warehouse:
•
•
•

Managing material stocks
Managing storage bins
Triggering warehouse movements (stock removal, putaway, stock transfers and posting
changes)
• Carrying out the inventory
• Determining the storage bins for warehouse movements based on fixed putaway and
stock removal strategies
The external system takes over the entire warehouse controlling:
•
•
•

Controlling the conveyor equipment
Controlling the material flow
Optimizing resources

If you want to implement the WMS together with a fully automated external
system, you should also consider the “black box” scenario [Seite 15] and the
scenario for connecting an external warehouse management system [Seite 18].

Prerequisites
You have set up the interface between the WMS and the external system in the Customizing
for Warehouse Management under Interfaces → External Systems → Configure Warehouse
Management [Extern].
You have defined how the warehouse management tasks are to be divided between the
WMS and the external system. Here, the level of automation in the warehouse plays an
important role:
• For simple automated warehouses, the WMS usually takes on all of the warehouse
management tasks. The external system takes on the warehouse controlling functions,
whereby warehouse movements triggered by the WMS can be optimized on the basis of
warehouse controlling. For more information, see Connecting a Semi-Automated
Warehouse [Seite 7].
• For warehouses with complex automation, you should take the technology in the
warehouse into account as early as during transfer order creation. The external system
then takes on some of the warehouse management tasks. You therefore the material in
this kind of storage type via identification points [Extern] (ID points) and pick points
[Extern].

Depending on the WMS movement type in the TO, the system steers the
warehouse technology towards various picking points.
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Process Flow
Putaway via ID points
SAP WMS

External System

Triggers
Warehouse Movements
Defines Destination
Storage Type
Creates TO from
GR Area to ID Point
Prints Pallet Note
With Barcode
Transfers TO
to External System

WCU Interface
WMTORD

Scan Pallet Note
into External System
Determines Pallet Type
Assigns Dest. Storage Bin
Executes
Warehouse Movement

WCU Interface

Creates TO for
Goods Movement

Reports Back
Goods Movement

WMSUMO

13. You receive an inbound delivery in the goods receipt interim storage area. You post the
goods receipt for the inbound delivery and enter the pallet (storage unit) in the WMS.
14. The WMS determines the destination storage type for the storage unit (SU) that has been
delivered.
15. If the stock is to be put away via an ID point, the WMS creates a transfer order (TO) from
the goods receipt interim storage area to the ID point.
16. The WMS transfers the TO with the necessary data for the putaway (including the pallet
number) using the message type [Extern] WMTORD.
17. You print the TOs to use as pallet notes.
The destination storage bin for putaway is printed on the pallet note in the form of a
barcode.
18. You transport the SU to the ID point.
19. The external system identifies the SU at the ID point on the basis of the barcode on the
pallet note.
20. To achieve optimal utilization of the conveyor equipment during putaway, the external
system assigns the destination storage bin for the SU.
21. The external system takes the SU to the destination storage bin and puts it away.
22. Using message type WMSUMO, the external system reports back to the WMS that the
warehouse movement has been executed for the storage unit.
The external system constructs the transfer order data in the form of an IDoc in the
external system and sends the IDoc to the WMS.
23. The WMS creates the transfer order for the stock putaway on the basis of the data
transferred using message type WMSUMO, in order to post the warehouse movements
triggered by the external system.
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Stock removal via a pick point
SAP WMS

External System

Triggers
Warehouse Movements
Defines Method and
Extent of Stock Removal
Creates TO from
Warehouse to GI Area
Transfers TO to
External System

WCU Interface
WMTORD

Sends Release
of Group

WCU Interface
WMRREF

Defined Optimal
Stock Removal Sequence
Removes Stock to
Picking Point
Displays the Items
to be Picked

WCU Interface

Confirms the
Reported TOs

WMTOCO

Reports Stock
Removal Back to WMS
Determines Return Storage
Bin for SU Remaining Qty
Returns SU to Storage

Creates TOs for the
Reported Return to Storage

WCU Interface
WMSUMO

Reports Return to
Storage to the WMS

7. You trigger stock removal or picking in the WMS by, for example, grouping together the
pick for several outbound deliveries in collective processing.
8. The WMS creates TOs for the outbound deliveries.
9. The WMS transfers the TOs to the external system using the message type WMTORD.
If you want to execute picking on the basis of outbound deliveries, the system treats
each transfer order that is transferred as an independent pick order.
If you want to control picking according to other criteria (for example, relating to a
route), you must ensure that the transmitted transfer orders are only picked by the
external system once all of the relevant TOs have been transferred to the external
system.

10.
11.

12.
13.
14.

The TOs for a group can only be picked in the external system once the WMS
has transmitted the release of the group using message type WMRREF.
The external system processes the pick order, which can consist of one or more
transferred TOs.
The external system optimizes the individual warehouse movements from the pick order,
by determining the order in which the necessary storage units are to be removed from
storage.
If several pick points exist, the external system also assigns the individual picking
activities and SUs to the available pick points. Only the external system can ensure
optimal pick point assignment, since the utilization of the warehousing equipment is at
the fore.
You execute picking at the pick point.
The external system displays the items to be picked on the screen at the pick point.
You confirm the pick and enter any differences that occured.
The external system reports back to the WMS that the pick has been executed for the
individual storage units using message type WMTOCO.
The external system constructs the transfer order data in the form of an IDoc in the
fork lift control system and sends the IDoc to the WMS.
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15. The WMS confirms the transfer order on the basis of the data that was transferred using
message type WMTOCO.
Returning the storage unit with the remaining quantity to storage
1. After the pick, you take the SUs with the remaining quantities to the ID point so that they
can be returned to storage.
2. The external system identifies the storage units at the ID point, by way of a contour
control.
3. To achieve optimal utilization of the conveyor equipment during putaway, the external
system assigns the destination storage bin for the SU.
4. The external system takes the SU to the destination storage bin and puts it away.
5. The external system reports back to the WMS that the warehouse movement has been
executed for the storage unit using message type WMSUMO.
The external system constructs the transfer order data in the form of an IDoc in the
external system and send the IDoc to the WMS.
6. The WMS creates the transfer order for the stock putaway on the basis of the data
transferred using message type WMSUMO, in order to post the warehouse movements
triggered by the external system.
For more information about returning storage units to stock, see Partial Picking [Extern] and
Picking via the Pick Point [Extern].

Blocking Storage Bins
In automated warehouses, certain storage bins may not be accessible for the conveyor
equipment.

Certain routes become inaccessible for the conveyor equipment, or certain
storage bins can no longer be reached by the warehouse equipment.
Since you manage the warehouse in the WMS, you need to block these storage bins in the
WMS as quickly as possible so that the WMS cannot plan any more warehouse movements
for these storage bins.
The external system transfers the storage bins need to be blocked to the WMS using
message type WMBBIN.
To trigger the WMS to lift the block on the blocked storage bins, the external system transmits
the relevant storage bins or aisles to the WMS using message type WMBBIN.
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Connecting a Fully Automated Warehouse as a
Black Box
Purpose
You have set up various storage types [Extern] in your warehouse complex (warehouse
number [Extern]),which you manage with the Warehouse Management system (WMS). For
one or more of these storage types, an external system executes all of the warehouse
functions and thus takes over the entire warehouse management and warehouse control
for this storage type.
The automated storage type is connected to the WMS as a black box. The WMS leaves the
entire warehouse management and warehouse control in this storage type to the external
system, since the storage type is highly automated and therefore requires immediate
information about the current state of the warehouse equipment for the warehouse
movements.

If you want to connect this kind of storage type to your warehouse, we
recommend that you implement a system which combines warehouse controlling
and warehouse management.
Since the automated storage type only represents a part of your warehouse complex, you can
manage the overall warehouse complex (the warehouse number) with the WMS. The WMS
distributes the individual putaway and stock removal activities amongst the various
subordinate storage types. The WMS takes on the conventional functions in all of the storage
types, which are not managed by the external system.
In the storage types, which are managed by the external system, the WMS takes on the
following functions:
• Managing the summarized stocks per material
• Triggering and creating warehouse movements
On the other hand, the external system takes over the entire warehouse management and
warehouse control within the storage type:
•
•
•

Determining the storage bins for the individual warehouse movements
Creating warehouse movements within the storage type
Carrying out the inventory

•
•
•

Controlling the conveyor equipment
Controlling the material flow
Optimizing the resources

When you decide on the type of interface connection, take into account the
scenario for connecting a fully-automated warehouse [Seite 11] and the scenario
for connecting an external warehouse management system [Seite 18] as well.

Prerequisites
You have defined the automated area of your warehouse as a separate storage type in the
WMS.
• Either you define one fixed storage bin [Extern] per material in this storage type, in order
to be able to manage the stocks for each material in the storage type and control
inventory activities,
• Or you define several storage bins in the warehouse type, which do not correspond to the
physical storage bins. In doing so, you allow addition to existing stock for this storage
type, so that the system always fills one storage bin with one material. The system
cumulates the stocks of a material in one storage bin. A new material always goes into a
new storage bin.
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The storage bins that you created in the WMS for the individual materials have no
significance for the external system.

Process Flow
SAP WMS

External System

Communicate With Other
SAP App. Components.
Triggers
Warehouse Movements
Creates the TO
(Storage Bin is Irrelevant)
Transfers TO
to External System

WCU Interface
WMTORD

Defines Storage Bins for
Putaway and Stk Removal
Optimizes the
Material Flow
Executes
Goods Movements

WCU Interface

Confirms the
Reported TOs
Creates TOs for the
Reported Differences

Reports Goods Movements
Back to the WMS

WMTOCO

Carries Out Inventory
WCU Interface
WMTOCO

Reports Differences
to WMS
Triggers and Executes
Intern. Whse Movements

The WMS communicates with other SAP application components for the entire warehouse
number.

Putaway
1. You post the goods receipt of the goods in Inventory Management.
2. The WMS creates transfer orders for putaway on the basis of the corresponding transfer
requirements. In doing so, the WMS defines the storage type in which the goods are to be
put away.
3. If the storage type run by the external system is selected for the putaway, the WMS
transfers the corresponding TO items to the external system using the message type
[Extern] WMTORD.
4. The external system identifies the goods to be put away either by the TO number and the
TO items, or from the transmitted SU number.
5. If the WMS requires confirmation of the goods movement, the external system reports
back to the WMS that the putaway has been executed using message type WMTOCO.

Stock Removal
1. The WMS creates a transfer order (TO) for the stock removal.
2. The WMS sends the external system all of the stock removal TOs that are relevant for the
storage type managed by using message type WMTORD.
3. The external system decides from which storage bin the necessary materials are to be
removed.
4. The external system confirms the stock removal to the WMS using the message type
WMTOCO.
5. The WMS confirms the individual items in the transfer orders based in the confirmation
data and the actual quantities from the external system.
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Handling Differences
If differences occur in the storage type managed by the external system, either during an
inventory or during operation, the external system reports these differences to the WMS via
message type WMTOCO.
The WMS creates a transfer order on the basis of the differences transmitted by the external
system, in order to post the differences to an interim record for differences.
See also:
Handling Differences [Extern]

The external system must not transmit all of the material movements within the
storage type managed by the external system to the WMS, since the WMS only
manages the summarized material for this storage type.
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Connecting an External Warehouse Management
System
Use
Your Enterprise Resource Planning system (ERP System) is an SAP R/3 System, to which
you connect an external system that that takes on all warehouse controlling and warehouse
management functions for the entire warehouse.
The reasons for connecting an external system to an SAP R/3 System as a complete
warehouse management system include:
• Along side a fully auomated warehouse [Seite 11], there are no other storage types which
you manage with the Warehouse Management system (WMS).
•

You implement the SAP ERP System in a storage area, which is already managed by an
external system. You want to retain this warehouse management system.

Connection via the interface to the decentralized WMS
For more information, see Decentralized Warehouse Management [Extern].

Connection via lean WM
You use lean WM [Extern] to communicate between the external warehouse management
system and the SAP ERP System.
You set up the interface between the WMS and the external system in the Customizing for
Warehouse Management under Interfaces → External Systems → Configure Warehouse
Management [Extern].
You define the warehouse managed by the external system as a storage type in the WMS.
• Either you define one fixed storage bin [Extern] per material in this storage type, in order
to be able to manage the stocks for each material in the storage type and control
inventory activities,
• Or you define several storage bins in the warehouse type, which do not correspond to the
physical storage bins. In doing so, you allow addition to existing stock for this storage
type, so that the system always fills one storage bin with one material. The system
cumulates the stocks of a material in one storage bin. A new material always goes into a
new storage bin.

The storage bins that you created in the WMS for the individual materials have no
significance for the external system.

Connection via component interfaces
The external warehouse management system communicates with the SAP ERP System via
several component interfaces:
• Communication with Inventory Management (MM-IM)
Transmission of goods movements occurs via the message type [Extern] MBGMCR.
For more information, see Inventory Management and Physical Inventory → Maintain
Customer Exits and Business Add-Ins → Maintain Customer Exits for Inventory
Management [Extern] (for MB_CF001) and Maintain Business Add-Ins for Inventory
Management [Extern] (for BAdI MB_DOCUMENT_BADI) in the Implementation
Guide for Materials Management.
• Communication with Production Planning (PP)
In Production Planning, there is a user exit for production orders. You can find this
user exit via transaction /nCMOD for package CO.
• Communication to Sales and Distribution (SD)
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For more information, see Electronic Data Interchange/Idoc Interface [Extern] (SDEDI).
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Connecting an Non-Warehouse Management
System
Purpose
You can connect non-warehouse management systems to the Warehouse Management
system (WMS) as external systems. These are usually Enterprise Resource Planning
systems, which transmit the requests for goods movements to the WMS. These include:
• External pick systems or shipping systems
• External production planning and production control systems
•

External inventory management systems

Prerequisites
You have set up the interface between the WMS and the external system in the Customizing
for Warehouse Management under Interfaces → External Systems → Configure Warehouse
Management [Extern].

Process Flow
When the WMS receives requests for warehouse movements from an external system, the
WMS creates transfer requirements [Extern] on the basis of these requests. Transfer orders
are created in the system on the basis of these transfer requirements, with which you execute
the physical warehouse movements.

1.
2.

3.
4.
5.

It is not possible to report the confirmation of the transfer orders, that is to say,
confirmation that the requested warehouse movements have been executed,
back to the external system.
The external system defines the extent of the warehouse movements that is required.
The external system requests the warehouse movements via the WMS interface.
In doing so, the external system constructs the necessary data and transmits the
request via the message type [Extern] WMTREQ.
The WMS creates transfer requirements based on the transmitted request.
The WMS creates transfer order for executing the requested warehouse movements on
the basis of the transfer requirements.
You execute the physical warehouse movements based on the transfer orders from the
WMS.
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Data Flow: WMS Transfers Data
The data flow across the interface between the Warehouse Management system (WMS) and
the external system (WMS-WCU interface) is explained using the example of the
communication flow for transferring transfer order data from the WMS to the external system.
For further information on the business background, see Scenarios for Connecting External
Systems [Seite 6].

Prerequisites
You have defined the necessary TCP/IP settings. For more information, see BC – SAP
Communication: Configuration [Extern].
You have defined the ALE interface in the Customizing for Warehouse Management under
Interfaces → External Systems → Configure Warehouse Management [Extern] → Warehouse
Management View → Activate Interface per Whse Number.
You have defined when a transfer order (TO) is relevant for transfer to the external system in
the Customizing for Warehouse Management under Interfaces → External Systems →
Configure Warehouse Management → R/3 System -> External System → Define Interface
Control.
•

You can define that TO items are relevant for transfer to the external system:
− For a storage type
− For a WMS movement type
−

•

For a combination of storage type and WMS movement type

You define the external system, which receives the TO item.

Process Flow
1. During TO creation in the WMS, the system determines from the Customizing settings,
that the TO or a TO item is relevant for transfer to the external system.
2. During TO creation, the system prepares the data to be transferred in the form of an IDoc
[Extern].
NOTE
For further information on IDocs and their construction, see Description of the
IDocs [Seite 31].
3. The system saves the IDoc in the database.
4. After creating the IDoc, the system triggers the transfer of the IDoc to the external system
asynchronously.
The system can transfer individual IDocs or collect several IDocs and then transfer
them to the external system later. The transfer is based on the Remote Function Call
[Extern].
4. The external must be available with a corresponding program to receive the data
transferred from the WMS.
For more information, see Basis → Basis Services/Communication Interface →
Remote Communications → The RFC API → Programming with the RFC API
[Extern].
5. The external system saves the IDoc data it receives and sends a delivery receipt back to
the SAP system.

We recommend saving the data in the external system straight away to ensure
that the transfer of the IDoc and processing of the transferred data occurs
separately.
6. Status management for the data received should prevent the external system from
processing the data twice.
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The external system should be able to recognize IDocs that have been transferred by
the SAP system before. This is made possible by the unique transaction identification
number (transaction ID), which the SAP system assigns for each communication
process. For more information, see Basis → Basis Services/Communication Interface
→ Remote Communications → The RFC API → Transactional RFC Client Programs
[Extern].

The external system can also recognize double transfers from the IDoc number.
Note that an IDoc number is only unique within one client of an SAP system. If
several clients of an SAP system or several SAP systems are involved in the
communication with the external system, the IDoc number is no longer unique. In
this case the external system cannot recognize IDocs that have been transferred
twice from this number.

Error Processing
When you send an IDoc from the WMS to an external system, the following problems may
occur:
Troubleshooting
Symptom

What You Should Know

Update termination in the SAP system during
the application

An update termination during creation of a
transfer order does not affect communication
with the external system, because the system
only creates an IDoc once the source SAP
system document exists.
The TO and the IDoc are creates in the same
LUW, therefore they are updated
synchronously.

Error in the ALE interface:
Transferred data is syntactically incorrect

ALE adopts the IDoc and saves it, but cannot
transfer the IDoc to the external system. For
more information, see IDoc Error Processing
[Seite 69].

Error in the ALE interface:

For more information, see IDoc Error
Processing [Seite 69].

•

The outbound partner profile for the
receiving system
• The IDoc message type
are not defined
There is no connection between the SAP
system and the external system

The SAP system tries to set up the connection
to the external system by running a report in
the background at a later time. As soon as the
connection between the two systems exists
again, the SAP system automatically transfers
all IDocs, which have not yet been sent. You
can also start this report manually.
For more information, see Processing
Technical IDoc Errors [Seite 73].
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TCP/IP Settings
As a prerequisite for communication, make the following TCP/IP settings:
• The TCP/IP requirements must be met (especially the IP addresses in the hosts files) so
that the SAP system can find the destination system.
• Enter the name of the gateway and the dispatcher in the file services, for example
sapgw00 and sapdp00.
•

By default, IDocs are sent out from the update in the R/3 System. For this reason, the
TCP/IP link must also be created for the updating system.
• Work in registration mode. By doing so, the connection between the external system
program and the gateway remains open. For more information, see Registering Server
Programs with the SAP Gateway [Extern].
If you do not work in registration mode, the SAP Gateway should be able to start the
external program (RFC server) via the remote shell.
For more details on the TCP/IP settings, see the documentation BC – SAP Communication:
Configuration [Extern].
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Transaction Identification Management (TID)
A unique code must be used for a communication process in order to guarantee the integrity
of the data to be transferred. The receiving system can then use this code to decide whether
this data has already been received and processed.

For example, communication may break down during data transmission when
goods receipts are entered on mobile data entry devices. The person handling
the data would then have to send it again to make sure that it is posted in the
SAP system. If, however, the data was successfully received and processed the
first time it was sent to the SAP system, the system must be able to recognize
this and then not process the second data record.
This example inevitably results in the following sequence of operations between the sending
and receiving system.

Sender
Sender
( (Client
Client) )

Recipient
Recipient
((Server
Server))

Generate
Generate//Get
GetTID
TID

(world-wide
(world-wideunique
uniquenumber)
number)

Save
SaveTID
TIDwith
withdata
datarecords
records
that
are
to
be
that are to besaved
saved

Call
Callto
toServer:
Server:
Transmit
Transmitdata
dataand
andTID
TID

Confirmation
Confirmation
not
noto.k.
o.k.

Confirmation
Confirmation
o.k.
o.k.

Save
Savedata
data
and
andTID
TID

Confirmation:
Confirmation:
Receive
Receivedata
data

Update
Updatestatus
status
Send
Sendagain
again
with
withsame
same
TID
TID

Delete
DeleteTID
TID
and
anddata
data
immediately
immediately
or
orlater
later

Check:
Check:TID
TIDexists
existsalready
already/ /
processed?
processed?

Yes
Yes

do
donothing
nothing

No
No

Process
Processdata
data

Update
UpdateTID
TIDstatus
status
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Data Flow: WMS Receives Data
The data flow across the interface between the Warehouse Management system (WMS) and
the external system (WMS-WCU interface) is explained using the example of the
communication flow for transferring data relevant to a transfer order (TO) from the external
system to the WMS.
For further information on the business background, see Scenarios for Connecting External
Systems [Seite 6].

Prerequisites
You have defined the necessary TCP/IP settings. For more information, see BC - SAP
Communication: Configuration [Extern].
You have defined the ALE interface in the Customizing for Warehouse Management under
Interfaces → External Systems → Configure Warehouse Management [Extern] → Warehouse
Management View → Activate Interface per Whse Number.

Process Flow
1. The external system saves the data relevant for transferring to the SAP system and
formats it in an IDoc.
5. The external system transfers the IDoc with an appropriate program.
The transfer is based on the Remote Function Call [Extern]. For more information,
see Basis → Basis Services/Communication Interface → Remote Communications →
The RFC API → Programming with the RFC API [Extern].
The central function module is in the ALE layer. As soon as the external system calls
the function module on the SAP system side, the external system can transfer several
IDocs.

If an IDoc type is only designed to be transferred individually, this is noted in the
relevant IDoc system documentation.
7. Status management for the data to be transferred should prevent the external system
from not transferring data.

If the system cannot successfully transfer IDocs, you must ensure that these
IDocs are transferred again at a later time.
8. The SAP system should be able to recognize IDocs that have been transferred by the
external system already. This is made possible by the unique transaction identification
number (transaction ID), which the SAP system assigns for each communication process.
For more information, see Basis → Basis Services/Communication Interface → Remote
Communications → The RFC API → Transactional RFC Client Programs [Extern].
The external system must always provide the transferred data with this transaction
ID. If the external system transfers an IDoc for a second time due to unsuccessful
communication at an early time, the external system must issue the same transaction
ID again.

6.
7.
8.
9.

The SAP system does not use the IDoc number to recognize a double transfer
of IDocs from the external system.
The SAP system receives the transferred IDoc via ALE, saves the IDoc in the database,
and confirms receipt of the IDoc to the external system.
ALE transfers the IDoc to WMS asynchronously on receipt of the IDoc and the WMS
takes over the processing of the IDoc.
The WMS creates transfer orders on the basis of the transferred data.
For each IDoc, the WMS reports a processing status back to ALE.
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On the basis of the processing status, ALE triggers error processing of the IDoc
where necessary.

Error Processing
When you receive an IDoc in the WMS from an external system, the following problems may
occur:

Troubleshooting
Symptom

What You Should Know

There is no connection between the external
system and the SAP system

Using status management, the external system
should ensure that IDocs can be transferred
again at a later time.

Error in the ALE interface:
There are syntactical errors in the data that the
external system sent to the ALE

ALE adopts the IDoc and saves it, but cannot
transfer the IDoc to the WMS for processing.
For more information, see IDoc Error
Processing [Seite 69].

Error in the ALE interface:

For more information, see IDoc Error
Processing [Seite 69].

•

Inbound partner profile for the sending
system

• IDoc message type
are not defined
Application errors in the WMS

If errors occur in the processing of the received
IDoc, the WMS transfers the processing status
correspondingly. For more information, see
Processing Logical IDoc Errors in the WMS
[Seite 76].
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Data Formatting
The system transfers data to structures EDI_DC40 and EDI_DD40. Since these structures
are also used for EDI, some of the fields are redundant for the WMS-WCU interface.
For more information see Basis → Basis Services/Communication Interface → The IDoc
Interface → IDoc Interface/Electronic Data Interchange → Processing IDocs → Inbound
Processing → Inbound Processing: Technical Background [Extern].

EDI_DD40
Field

Format

Description

TABNAM

CHAR 10

Table structure
name

Not relevant

MANDT

CLNT 3

Client

DOCNUM

CHAR 16

IDoc number

SEGNUM

CHAR 6

SAP segment
number

SEGNAM

CHAR 10

SAP segment
name

Not relevant, but
transferred to
external system
Unique
communication
number
Sequential
numbering of
IDoc segments is
transferred to the
external system,
but is not
required during
receipt.
IDoc segment
name

PSGNUM

CHAR 6

Number of
higher-level SAP
segment

Transferred to
external system,
but not
imperative during
receipt

HLEVEL

CHAR 2

Hierarchy level of
SAP segment

Transferred to
external system,
but not
imperative during
receipt

DTINT2

CHAR 2

Empty field for
EDI_DD

Not relevant

SDATA

LCHR 1000

Application data

Feld

Format

Description

TABNAM

CHAR 10

Table structure
name

Relevant for
Receipt

X

X

X

Note

Actual
application data
in form of IDoc
segment

EDI_DC40

Interface Between the WMS and External Systems

Relevant for
Receipt

Note

620

27

SAP Online Help

07.10.2002

MANDT

CLNT 3

Client

DOCNUM

CHAR 16

IDoc number

DOCREL

CHAR 4

IDoc SAP
release

STATUS

CHAR 2

IDoc status

DOCTYP

CHAR 8

IDoc type

DIRECT

CHAR 1

Direction

RCVPOR

CHAR 10

Recipient port

RCVPRT

CHAR 2

Partner type of
recipient

X

Value: “LS”

RCVPRN

CHAR 10

Partner number
of recipient

X

For example:
“WM_SUB_0
01” for SAP
to SUB

RCVSAD

CHAR 21

EDI: Total SADR
fields

RCVLAD

CHAR 70

Logical address
of recipient

STD

CHAR 1

EDI standard

STDVRS

CHAR 6

Version of EDI
standard

STDMES

CHAR 6

EDI message
type

MESCOD

CHAR 3

Logical message
code

*

Both fields can
be used to define
a function
module other
than the
standard for
processing the
IDoc in the ALE
service layer in
the table of input
methods

MESFCT

CHAR 3

Logical message
function

*

Both fields can
be used to define
a function
module other
than the
standard for
processing the
IDoc in the ALE
service layer in
the table of input
methods
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OUTMOD

CHAR 1

Output mode

TEST

CHAR 1

Test indicator

SNDPOR

CHAR 10

Sender port

SNDPRT

CHAR 2

Partner type of
sender

X

Value: “LS”

SNDPRN

CHAR 10

Partner number
of sender

X

For example:
“S11MAN000“ if
S11 is the
sending SAP
system

SNDSAD

CHAR 21

EDI: Total SADR
fields

SNDLAD

CHAR 70

Logical address
of sender

REFINT

CHAR 14

Reference to
transfer data

REFGRP

CHAR 14

Reference to
message group

REFMES

CHAR 14

Reference to
message type

ARCKEY

CHAR 70

EDI archive key

CREDAT

DATS D 8

IDoc creation
date

CRETIM

TIMS T 6

IDoc creation
time

MESTYP

CHAR 6

Logical message
type

X

For example
WMTORD
for transfer
orders

IDOCTYP

CHAR 8

Name of basis
IDoc

X

For example
WMTOID01
for TOs

CIMTYP

CHAR 8

Name of
intermediate
structure

RCVPFC

CHAR 2

Partner function
of recipient

SNDPFC

CHAR 2

Partner role of
sender

SERIAL

CHAR 20

EDI/ALE:
Serialization field

EXPRSS

CHAR 1

Override during
receipt
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You must not fill all of the EDI_DC and EDI_DD fields. Make sure that you
initialize the fields that should not be filled first.
On creation of the IDoc in the SAP R/3 system with transaction /nWE30, the system
automatically creates three structures for each IDoc segment, which are also numbered
sequentially, for example for the transfer order item E1LTORI, E2LTORI, and E3LTORI.
E1LTORI is release-independent, E2LTORI release-dependent, and E3LTORI is used for
documentation.

We recommend choosing the E2 segment names during transfer of the segment
name, since this is independent of the SAP release.

Example
If, for example, you send a transfer order with three items for each IDoc from the external
system to the Warehouse Management System (WMS), you transfer one header segment
and three item segments per IDoc. In doing so, you send one EDI-DC40 record and four
EDI_DD40 records per IDoc. The four segments of an IDoc are pinned together with the
unique number of the IDoc. The corresponding EDI_DC record is also identified from the
DOCNUM.
You transfer two internal tables with the following construction:

EDI_DD40
9000000000123456

E2LTORH

9000000000123456
9000000000123456
9000000000123456
9000000000123457

E2LTORI
E2LTORI
E2LTORI
E2LTORH

9000000000123457

E2LTORI

9000000000123457
9000000000123457

... (TO header data)

E2LTOR
E2LTORI

00112345678905011
E
0001FRASCATI
0002BORDEAUX
0003CHIANTI
00112345678912011
A
0001CHATEAUNEUF
0002BORDEAUX
0003SOAVE

DS
DS

DS
DS

WMTORD
WMTORD

... (Item)
... (Item)
... (Item)
... (TO header data)
... (Item)
... (Item)
... (Item)

EDI_DC40
9000000000123456
9000000000123457

S11MAND002
S11MAND002
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Description of the IDocs
The interface between the Warehouse Management system and external systems (WMSWCU interface) uses the following IDocs:

WMS-WCU interface IDocs
IDoc

Partner Profile

Message Type

Validity

Description

WMTOID01

Inbound and
outbound

WMTORD

As of 3.0A

Transfer order

WMTOID02

Inbound and
outbound

WMTORD

As of 4.6C

Send pick HU

WMTCID01

Inbound

WMTOCO

As of 3.0A

Transfer order
confirmation

WMTCID02

Inbound

WMTOCO

As of 4.0A

Transfer order
confirmation

WMTCID03

Inbound

WMTOCO

As of 4.6C

Transfer order
confirmation

WMCAID01

Inbound and
outbound

WMCATO

As of 3.0A

TO cancellation/
cancellation
request

WMTRID01

Inbound

WMTREQ

As of 3.0A

TO creation

WMBIID01

Inbound

WMBBIN

As of 3.0A

Storage bin
blocking

WMRRID01

Outbound

WMRREF

As of 3.0A

Releasing
Groups

WMSUID01

Inbound

WMSUMO

As of 3.0A

Moving a storage
unit

WMIVID01

Inbound

WMINVE

As of 3.0A

Physical
inventory
document and
count data entry

WMINID01

Inbound

WMINFO

As of 3.0A

Information text

Interface Between the WMS and External Systems

620

31

SAP Online Help

07.10.2002

IDoc for Sending TOs to an External System
Definition
You use IDoc WMTOID01 or WMTOID02, in the Warehouse Management system (WMS), in
order to send data from transfer orders from the WMS to connected external systems.

The following describes IDoc WMTOID02 only.

Use
The WMS creates a transfer order for every warehouse movement, regardless of whether the
movement is a putaway, stock removal, stock transfer, or a posting change. The WMS
transfers the transfer order data to the connected external system in the form of IDoc
WMTOID02.
The external system requires a precise division of warehouse movements according to type.
You should differentiate between the transfer orders according to the respective warehouse
movement type.
•

Based on the data in the transfer order
− Movement type
− Transfer type

− Based on the storage types involved in the warehouse movement
• Based on the variant of the WM message, which you have defined in the definition of the
movement for connection to the interface.
Which IDoc the system fills and sends to the external system depends on several criteria:

Criteria

Details

Warehouse movement type

•

Putaway

•
•

Stock removal
Stock transfer

•

Posting change

Movement type

Defining the movement type
You define, for example, whether the goods
receipt date should be set during putaway.

Transfer order initiator

•

Manual TO

•
•
•

TO for inbound or outbound delivery
TO for transfer requirement (TR)
TO for material document
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Storage unit managed (SU-managed) storage
types

If SU-managed storage types are affected by
the warehouse movement, the system
transfers the numbers of the storage units
involved.
• For putaway in SU-managed storage
types, the system transfers the SU number
in field NLENR.
• For stock removals from SU-managed
storage types, the system transfers the SU
number in field VLENR.
• For stock transfers between SU-managed
storage types, the system transfers the SU
number in both fields.
If you transfer the complete SU, both
SU numbers are the same. If you
transfer material from one SU to
another, the system transfers both SU
numbers involved.

You determine the content on the IDoc for the individual customers. We
recommend creating test transfer orders for transmission to the external system,
so that you can check the content of the IDocs, which the system creates.

Structure
Message Type
You define the outbound partner profile for message type WMTORD.

Segments
IDoc WMTOID02 is made up of the following segments:
•
•
•

E1LTOIRH (transfer order header)
E1LTOIRI (transfer order items)
E1LPHUX (pick handling unit)

Segment definition E2LTORH004 (TA header) (released as of SAP R/3 4.6C)
Field

Format

Description

Required Entry

Note

LGNUM

CHAR 3

Warehouse
number

X

Activate linkage
in warehouse
number first

TANUM

NUMC 10

Transfer order
number

BWLVS

NUMC 3

Movement type
Warehouse
Management

TBPRI

CHAR 1

Transfer priority

TRART

CHAR 1

Transfer type

E = Putaway, A =
Stock Removal U
= Stock Transfer

REFNR

CHAR 10

Group

Grouping
individual TOs
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BETYP

CHAR 1

Requirement
type

BENUM

CHAR 10

Requirement
number

KZPLA

CHAR 1

Planned TO

PLDAT

DATS 8

Planned
execution date

PLZEI

TIMS 6

Planned
execution time

LZNUM

CHAR 20

Additional
reference
number to
transfer

BNAME

CHAR 12

User name

KISTZ

CHAR 1

Actual time
required in TO

KZLEI

CHAR 1

Performance
Data

PERNR

NUMC 8 –R-

User’s personnel
number

SOLWM

QUAN 15

Planned
processing time
from WMS

SOLEX

QUAN 15 –R-

Planned
processing time
from external
system

ISTWM

QUAN 15

Actually time of
WMS transfer
order

ZEIEI

UNIT 3

Time unit for
performance
data

STDAT

DATS 8

TO start date

ENDAT

DATS 8

TO end date

STUZT

TIMS 6

TO start time
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ENUZT

TIMS 6

TO end time

L2SKA

CHAR 1

Type of TO
within 2-step
picking

LGTOR

CHAR 3

(Goods
receipt/issue)
gate of
warehouse
number

LGBZO

CHAR 10

Staging area of
warehouse
number

NOSPL

CHAR 1 –R-

No TO split

The split criteria
predefined in the
system are
ignored

SWABW

NUMC 4

Threshold value
of variance from
planned/actual
time in TO

Determined
during TO
creation and
adopted in the
outbound IDoc

AUSFB

CHAR 4

TO processing
comment code

Allows
confirmation of
an indicator for
TO execution

VBTYP

CHAR 1

Sales document
type

The preceding
document to
which the TO
refers (for
example,
inbound delivery,
outbound
delivery, return
delivery)

QUEUE

CHAR 10

Queue

KGVNQ

CHAR 1

Separate
confirmation
possible

TAPRI

NUMC 2

TO priority

INCOM

CHAR 1

Create transfer
order, even if the
requested
quantity is only
partly met.

KVQUI

CHAR 1

Confirmation of
stock removal
occurs

Fields of segment E2LTORI004 (TO items) (released as of release 6.20)
Field

Format

Description
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TAPOS

NUMC 4

Transfer order
item

MATNR

CHAR 18

Material number

WERKS

CHAR 4

Plant

X

CHARG

CHAR 10

Batch number

X

If material is
subject to batch
management

BESTQ

CHAR 1

Stock category in
Warehouse
Management
system

X

If stock has
category

SOBKZ

CHAR 1

Special stock
indicator

X

If special stock

LSONR

CHAR 24

Special stock
number

X

If special stock

MEINS

UNIT 3

Base unit of
measure

X

LETYP

CHAR 3

Storage unit type

KZQUI

CHAR 1

Subject to
confirmation

KZNKO

CHAR 1

Execute zero
stock check

WEMPF

CHAR 12

Goods recipient

ABLAD

CHAR 25

Unloading point

WDATU

DATS 8

Goods receipt
date

WENUM

CHAR 10

Goods receipt
number

WEPOS

NUMC 4

Goods receipt
item

ZEUGN

CHAR 10

Certificate
number

VLTYP

CHAR 3

Source storage
type

X

VLBER

CHAR 3

Source storage
area

X

VLPLA

CHAR 10

Source storage
bin

X

VPPOS

CHAR 2

Item in source
storage bin

VSOLM

QUAN 15

Source target
quantity in
stockkeeping unit

X

NLTYP

CHAR 3

Destination
storage type

X
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NLBER

CHAR 3

Destination
storage area

X

NLPLA

CHAR 10

Destination
storage bin

X

NPPOS

CHAR 2

Item in source
storage bin

NSOLM

QUAN 15

Destination
target quantity in
stockkeeping unit

RLTYP

CHAR 3

Return storage
Type

RLBER

CHAR 3

Return storage
area

RLPLA

CHAR 10

Return storage
bin

RPPOS

CHAR 2

Item in return
storage bin

RSOLM

QUAN 15

Return target
quantity in
stockkeeping unit

MAKTX

CHAR 40

Material
description

VLENR

CHAR 20

Source storage
unit number

NLENR

CHAR 20

Destination
storage unit
number

VFDAT

DATS 8

Shelf life
expiration date

HOMVE

CHAR 1

Indicator:
Removal of an
entire
homogeneous
storage unit from
stock

QPLOS

NUMC 12

Inspection lot
number

QPLOA

NUMC 12

Inspection lot
from which
usage decision
was met

KZSTI

CHAR 1

Indicator:
Inspection
sample

KOBER

CHAR 3

Picking area

LGORT

CHAR 4 –R-

Storage location

SOLPO

QUAN 15

Target expense
for transfer order
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item

ZEIEI

UNIT 3

Time unit for
performance
data

L2SKR

CHAR 1

Relevance for
two-step picking

VOLUM

QUAN 15

Volume

VOLEH

UNIT 3

Volume unit

KGVNQ

CHAR 1

Separate
confirmation
possible

NPLEI

CHAR 1

Destination
storage bin can
be changed on
confirmation

QUSUB

CHAR 1

Two-step
confimation for
external system

NWIRM

QUAN 15

Transferred
active ingredient
quantity

WIRME

UNIT 3

Active ingredient
unit of measure

PVQUIT

CHAR 1

Material
withdrawal has
been confirmed

FHUTA

CHAR 1

TO item is HUTO item

VNEST

CHAR 1

Source SU is a
nested HU

VHILM

CHAR 18

Packaging
material

VDUMM

CHAR 1

Source SU is a
pseudo SU (only
HUs)

NDUMM

CHAR 1

Destination SU is
a pseudo SU
(only HUs)

VSERI

CHAR 1

Source SU is an
HU with serial
numbers

MATNR_EXTER
NAL

CHAR 40

Long material
number (future
development)

MATNR_VERSI
ON

CHAR 10

Version number
(future
development)

MATNR_GUID

CHAR 32

External GUID
(future
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Segment definition E2LPHUX001 (pick handling unit) (released as of release 4.6C)
Field

Data Type

Description

Required Entry

Note

LGNUM

CHAR 3

Warehouse
number

X

Switch on
linkage in
warehouse
number

TANUM

NUMC 10

Transfer order
number

X

EXIDV

CHAR 20

External HU ID

HUKNN

CHAR 18

Identifaction of
an HU in a TO

VHILM

CHAR 18

Packaging
material

LETYP

CHAR 3

Storage unit type

LGTYP

CHAR 3

Storage type

LGPLA

CHAR 10

Storage bin

VBELN

CHAR 10

Delivery

KZFIX

CHAR 1

Pick HU must not
be changed

KZRTN

CHAR 1

Pick HU
transferred to
initiator

ANZHU

DEC 4

Number of HUs
needed

VHILM_EXTERN
AL

CHAR 40

Long material
number (future
development) for
field VHILM

VHILM_VERSIO
N

CHAR 10

Long version
number (future
development) for
field VHILM

VHILM_GUID

CHAR 32

External version
number (future
development) for
field VHILM
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IDoc for Receiving TOs from an External System
Definition
You use IDoc WMTOID01 or WMTOID02 to send transfer order relevant data from the
external system to the Warehouse Management system (WMS).

The following describes IDoc WMTOID02 only.

Use
The external system triggers warehouse movements in a warehouse type and executes the
physical transportation of materials. Only then does the external system transfer the data on
the warehouse movements to the WMS.
You construct IDoc WMTOID02 in the external system, in order to transfer the warehouse
movement data to the WMS. The WMS receives the IDoc and creates a TO from it, in order to
execute the physical warehouse movements and post the storage bins involved. The WMS
creates a transfer order from the IDoc data it has received and immediately confirms it.
You can also create transfer orders with incomplete entries in the external system and
send these to the WMS. In this case, the WMS, as leading system, adds the missing entries
(for example, the coordinates of the destination storage bin) and sends the complete TO back
to the external system. The external system confirms the TO, completing the warehouse
movement.

Structure
Message Type
You define message type WMTORD for the inbound partner profile.

Segments
IDoc WMTOID02 is made up of the following segments:
• E1LTOIRH (transfer order header)
• E1LTOIRI (transfer order items)
• E1LPHUX (pick handling unit)
For more information in segment definition, see IDoc for Sending TOs to an External System
[Seite 32].
The external system may sometimes have to transfer additional data other then the segment
fields which are indicated as required entry fields. The extent to which this is the case
depends on some of the Customizing settings in Warehouse Management. For example,
these can include:

Entry

Effect on the IDoc

The movement type for putaway determines
the destination storage type and the source
storage type.

You must not transfer the source data (source
storage type, source storage area, and source
storage bin) in segment E1LTORI.
However, you must enter the destination data
with the destination storage type and
destination storage bin.

The movement type determines a stock
removal in a dynamic interface, which
corresponds to the cost center.

Segment E1TORI must contain the source
storage type and the source storage bin.
To determine the dynamic interface, segment
E1LTORI must contain requirement type K and
the requirement number of the cost center
assigned to the account.
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The movement type determines a stock
transfer within a warehouse number

Segment E1LTORI contains a source storage
type and source storage bin, and also a
destination storage type and destination
storage bin.

The movement type requires the goods receipt
date during putaway.

Segment E1LTORI must contain the goods
receipt date.

The movement type or the storage types
involved in the IDoc allow a return transfer.

If a return transfer has taken place, segment
E1LTORI contains the return transfer date.

A storage type is SU-managed.

•
•
•

•

If you add stock to an SU in this storage
type, segment E1LTORI contains the SU
number in field NLENR.
If you pick from an SU in this storage type,
segment E1LTORI contains the SU
number in field VLENR.
If you transfer a material quantity from an
SU in this storage type to another SU,
segment E1LTORI contains both SU
numbers.
If you transfer a material quantity from an
SU in this storage type to another SU,
segment E1LTORI contains both SU
numbers.

If you move a complete SU, use
IDoc WMSUID01 for the transfer.

Only use movement types for this IDoc, which allow immediate confirmation.
Usually, the physical warehouse movement has already taken place when you
receive information on a transfer order from the external system in the WMS.
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IDoc for Confirming Transfer Orders
Definition
Several IDocs are available for confirming a transfer order (TO) from the external system to
the Warehouse Management system (WMS).
•
•
•

WMTCID01 (as of release 3.0A)
WMTCID02 (as of release 4.0)
WMTCID03 (as of release 4.6C)

The following only describes IDoc WMTOID03.

Use
Using these IDocs, you confirm transfer orders that have been executed to the WMS. Based
on the confirmed data, the WMS confirms these TOs.

Prerequisite
You have defined which transfer orders require confirmation in the Customizing for
Warehouse Management under Master Data → Define Storage Type [Extern] or Activities →
Transfers → Define Movement Types [Extern]. For more information, see Confirming Transfer
Orders [Extern].
When sending the TO data, the WMS first transferred the data which requires confirmation in
IDoc WMTOID01 or WMTOID02 in segment E1LTROI with field KZQUI to the external
system.

We recommend that you simulate sending a cancellation reply from the external
system to the WMS, in order to test the relevant cancellation processes. Reports
RLCATO00 and RLCATO10 are available for testing cancellation.

Confirming Storage Units
If you work with storage units (SUs) in the warehouse and you move the entire storage unit,
you confirm one transfer order for the entire SU for this stock movement.
If a storage unit with mixed storage is involved and you move individual materials from it,
there are several transfer orders for this storage unit. You confirm the corresponding transfer
order for each stock movement.
If you determine that there are differences in the SU when you execute the TO, confirm the
entire storage unit and enter the difference quantities for the items for which differences
occurred.

Confirmation Without SU-Management
For stock removals, you normally confirm entire transfer orders.
For putaways, you can confirm TOs item by item if you put away several pallets with one TO.
If you confirm entire TOs, you can enter differences for individual TO items.

IDoc construction for confirmation
Case

Segment

Quantity

Meaning

A

E1LTCOX

1

Confirm complete SU

B

E1LTCOH

1

Confirm a complete
TO

C

E1LTCOH
E1LTCOI

1
1 to n

Confirm an entire TO
and enter differences
for items 1 to n.
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for items 1 to n.

D

E1LTCOH
E1LTCOI

1
1 to n

Confirm one or more
TO items

E

E1LTCOX
E1LTCOH
E1LTCOI

1
1 to m
1 to n

Confirm a complete
SU and enter
differences for TOs 1
to n with TO items 1
to n

Confirming Performance Data
You confirm performance data (actual TO processing time) to the WMS via segment
E1LTCOG. Normally, the WMS determines the planned TO processing time and adds to this
the planned processing time reported by the external system.
You can also report the actual data to the WMS independently of the confirmation, by only
sending segment E1LTCOG.
You can report actual data if the transfer order data was transferred to the external system
with the value 2, 3, or 4 for indicator KZLEI in IDoc WMTOID01 or WMTOID02.
Depending on the value of indicator KISTZ in IDoc WMTOID01 or WMTOID02, you confirm
the actual data in segment E1LTCOG as follows:

Value of Indicator KIST

Relevant Fields

1: Actual time as net duration

ISTWM
PERNR

Start and end time manual
Start and end time automatic

STDAT
STUZT
ENDAT
ENUZT
PERNR

Confirming Differences
If you determine during a stock movement that a difference exists, transfer these references
via IDoc WMTCID03 in segment E2LTCOI000, by filling the following fields:

Segment definition E2LTORH003 (TO header) (released as of SAP R/3 4.6C)
Field

Value

SQUIT

Blank

NISTA

Actual moved or removed quantity

NDIFA

Difference quantity of the stock movement:
Difference between the quantity in the TO and
the actual quantity moved

RISTA

Actual quantity of the return item if applicable

RDIFA

Difference quantity for return item

ALTME

Unit of measure to which the quantities refer
(from the TO that was already send)

KZDIF

If you want to override the storage type and the
storage bin to which the difference is posted

To confirm differences to the WMS, use case 3, 4, or 5.

Interface Between the WMS and External Systems

620

43

SAP Online Help

07.10.2002

You must confirm the entire actual quantity of the relevant TO item. The following
is valid for field VSOLM in structure E1LTORI:
VSOLM = NISTA + NDIFA + RISTA + RDIFA.

Confirmation for Zero Stock Check
For confirmation with zero stock check, use case 3 or 4.
For stock removal from a storage type with zero control, you must explicitly confirm the bin,
which has become empty as a result of the confirmed stock movement.
If the indicator KZNKO was set for the stock movement in IDoc WMTOID01 or WMTOID02,
IDoc WMTCID03 must confirm the zero stock check to the WMS in segment E1LTCOI.
If the storage bin is empty following the stock removal, set the indicator KZNUL in the IDoc.
If there is a remaining quantity in the storage bin, transfer the following fields in segment
E1LTCOI:

Field

Value

KZNUL

Blank

PISTA

Remaining stock counted
The system issues any remaining stock found
separately

ALTME

Unit of measure to which the quantities refer
(from the TO that was already send)

Even if the zero stock check was not required, the external system can confirm the zero stock
check to the WMS if the storage bin becomes empty as a result of the stock movement. In
this case, the physical stock level differs from the stock level in the system. For this, you set
indicator KZNKO in IDoc WMTCID02.

Confirming Batch-Managed Material
If, during goods movements, you confirm batch-managed material in SU-managed bulk
storage or in a warehouse with lean WM, you transfer the batch number of the materials that
have been removed with the confirmation data. To do this, you use field CHARG in segment
E2LTCOI004 (confirm batch for lean WM or bulk storage).

Stock Overview in SU-Managed Bulk Storage
You confirm the storage units (SUs) that have been removed to the WMS along with the
confirmation of the transfer order.

Confirm withdrawal of a complete SU
Field

Value

LENUM

Number of storage unit removed

VQUIT

X

Confirm withdrawal of the SU with difference and remaining quantity
Field

Value

LENUM

Number of storage unit removed

PICKM

Pick quantity

DIFFM

Difference quantity

RESTM

Remaining quantity
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Unit of measure upon which the quantities are
based

When confirmation of the individual SUs is complete for a TO item, set the field BQUIT in
segment E1LTCOI.
In this case, you confirm the TO item by item (see case 4). This means that there can be
several TO items per confirmation. Only one confirmation is permitted per storage unit
withdrawn.

If a material with batch management is involved, you transfer the batch number
along with the confirmation data. To do this, you use field CHARG in segment
E2LTCOI004 (confirm batch for lean WM or bulk storage).

Confirmation in Bulk Storage with Mixed Storage
If you confirm transfer orders for a bulk storage type with mixed storage, you must transfer the
quant data to the WMS for the material that has been moved. The WMS can only confirm the
transfer order if the goods movement is clearly assigned to certain quants.
•

You can determine the quant number of the material that has been moved via user exit
MWMIDI02 and confirm this to the WMS.

•

If the quant number of the material that has been moved is known in the subsystem,
transfer this quant number to the WMS by adding a “Quant number” field to segment
E1LTCOI for the confirmation.

Special Features of Confirmation for Lean WM
If you use lean WM, we recommend confirming the quant number to the WMS, since no quant
data is known in a warehouse with lean WM.
•

•

In this case, we recommend transferring the batch number of a material with batch
management during the confirmation of a goods movement to the lean WM.
You transfer the batch number of a batch-managed material with the confirmation
data via field CHARG in segment E2LTCOI004.
To confirm movements of consignment stock in lean WM, transfer the fields SOBKZ (with
the value K) and SONUM (the special stock number of the vendor).
If you use handling units, field PAPOS, along with TAPOS, serves as a pointer to the
HU data records that belong to the TO item in table T_LTAP_CONF_HU.

Structure
Message Type
You define message type WMTOCO for the inbound partner profile.

Segments
The IDoc for transferring confirmation data is constructed as follows:
• WMTCID01 (as of release 3.0A)

•

− E1LTCOX: Confirm entire storage unit
− E1LTCOH: Confirm TO header
− E1LTCOI: Confirm TO items
WMTCID02 (as of release 4.0)

•

− E1LTCOX: Confirm entire storage units
− E1LTCOG: Reporting performance data via confirmation
− E1LTCOH: Confirm TO header
− E1LTCOI: Confirm TO items
WMTCID03 (as of release 4.6C)
−

E1LTCOX: Confirm entire storage units
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−
−
−

E1LCOSE: Confirm with serial number
E1LCOHU: Confirm HU data per TO item
E1LTCOG: Reporting performance data via confirmation

−
−

E1LTCOH: Confirm TO header
E1LTCOI: Confirm TO items

Segment definition E2LTCOX002: Confirm storage unit (as of release 4.6A)
Field

Data Type

Description

Required Entry
Field

LGNUM

CHAR 3

Warehouse
number

X

LENUM

CHAR 20

Storage unit
number

X

QNAME

CHAR 12

User name for
confirmation

SQUIT

CHAR 1

Confirm entire
storage unit

NLPLA

CHAR 10

Destination
storage bin

The destination
storage bin is
based on the
deviating storage
bin of the
complete SU
(Customizing)

NPPOS

CHAR 2

Destination
position

The destination
storage bin
position is based
on the deviating
storage position
of the complete
SU
(Customizing)

ENAME

CHAR 12

User name of the
pick confirmation

QUKNZ

CHAR 1

Confirmation
indicator for
separate
confirmation

X

Note

Value ‘X’

1 = Confirm
stock removal
only
2 = Confirm
material transfer
only

Segment definition E2LCOHU000: HU data per TO item (as of release 4.5A)
Field

Data Type

Description

TANUM

NUMC 10

TO number

TAPOS

NUMC 4

TO item
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VONHU

CHAR 20

Source HU

NACHU

CHAR 20

Destination HU

SERNR

CHAR 18

Serial number

PAPOS

NUMC 4

Current number
of HU data row
within TO item

Segment definition E2LCOSE000: Confirm with serial number (as of release 4.5A)

Field

Data Type

Description

TANUM

NUMC 10

TO number

TAPOS

NUMC 4

TO item

VONHU

CHAR 20

Source HU

NACHU

CHAR 20

Destination HU

HUENT

CHAR 1

HU is removed
completely

MENGA

QUAN 15

Quantity for
repacking in
alternative unit of
measure

ALTME

UNIT 3

Alternative unit of
measure to stock
keeping unit

DMGEA

QUAN 15

Source
difference
quantity in
alternative unit of
measure

PAPOS

NUMC 4

Current number
of HU data row
within TO item

Required Entry
Field

Note

Segment definition E2LTCOG001: Report performance data (as of release 4.5A)
Field

Data Type

Description

LGNUM

CHAR 3

Warehouse
number

TANUM

CHAR 10

Transfer order
for which data is
confirmed

SOLEX

CHAR 15

Target
processing time
from external
system

PERNR

CHAR 8

TO processor
(personnel
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(personnel
number)

STDAT

CHAR 8

TO start date

ENDAT

CHAR 8

TO end date

STUZT

CHAR 6

TO start time

ENUZT

CHAR 6

TO end time

ISTWM

CHAR 15

WM-TO actual
processing time

AUSFB

CHAR 4

TO processing
comment code

Segment definition E2LTCOH003: TO header (as of release 4.6A)
Field

Data Type

Description

Required Entry
Field

LGNUM

CHAR 3

Warehouse
number

X

TANUM

CHAR 10

Transfer order
number

X

QNAME

CHAR 12

User name for
confirmation

SQUIT

CHAR 1

Indicator:
Confirm entire
transfer order

KOMIM

CHAR 1

Transfer pick
quantities to
delivery / post
goods issue (as
of release 4.0)

GI posting (2)
occurs only after
all of the items in
the delivery have
been confirmed

EINLM

CHAR 1

Transfer putaway
quantity to
inbound delivery

(See following
note)

TBELI

CHAR 1

Complete TR

Set the source
TR to
“completed” on
confirmation of
TO

ENAME

CHAR 12

User name of the
pick confirmation

QUKNZ

CHAR 1

Confirmation
indicator for
separate
confirmation
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<NOTE>
If you set the indicator KOMIM to 2, the IDoc can no longer be use for mass
processing: If you want to post the goods issue for an outbound deliver via the
IDoc, you can only transfer a single transfer order in the IDoc, for each IDoc and
communication activity.

If you confirm a TO for an inbound delivery, indicator EINLM determines whether
the putaway quantity is to be transferred to the inbound delivery and the goods
receipt is to be posted.
This indicator acts in the same way as indicator KOMIM for the outbound
delivery.

Segment definition E2LTCOI004: TO items (as of release 6.20)
Field

Data Type

Description

Required Entry
Field

TAPOS

CHAR 4

Transfer order
item

X

SQUIT

CHAR 1

Indicator:
Confirm without
difference

X

If the item is to
be confirmed
without any
differences

NISTA

CHAR 15

Destination
actual quantity

X

If there are
differences in the
destination
storage bin

NDIFA

CHAR 15

Destination
difference
quantity

X

If there are
differences in the
destination
storage bin

RISTA

CHAR 15

Return actual
quantity

X

If there are
differences in the
destination
storage bin

RDIFA

CHAR 15

Return difference
quantity

X

If there are
differences in the
destination
storage bin

KZNUL

CHAR 1

Indicator: Bin
empty on zero
stock check

X

If there is a zero
stock check

PISTA

CHAR 15

Remaining
quantity after
zero stock check

X

If there is a zero
stock check

ALTME

CHAR 3

Unit of measure

X

If quantity is
entered

KZDIF

CHAR 1

Differences
indicator

X

If you want to
post differences
to certain interim
record for
differences
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LENUM

CHAR 20

Storage unit
number

X

In case of
confirmation in
bulk storage

VQUIT

CHAR 1

Confirmation in
bulk storage,
removal of entire
SU

X

In case of
confirmation in
bulk storage

PICKM

CHAR 15

Pick quantity for
bulk storage
confirmation

DIFFM

CHAR 15

Difference
quantity in bulk
storage

RESTM

CHAR 15

Remaining
quantity on bulk
storage
confirmation

BQUIT

CHAR 1

Confirmation in
bulk storage, no
further items

KZFOL

CHAR 1

Indicator:
Subsequent
actions

You can use this
field individually,
for example to
trigger a userdefined process
via a user exit.
You can, for
example, trigger
a user-defined
follow-up action
for differences.

NLPLA

CHAR 10

Destination
storage bin

If the destination
storage bin
differs from that
suggested by the
system

NPPOS

CHAR 2

Destination
position

If the destination
storage bin
differs from that
suggested by the
system

PAPOS

NUMC 4

Current number
of HU data row
within TO item

PARTI

CHAR 1

Confirming a
partial quantity
for a TO item

CHARG

CHAR 10

Confirm batch
number for lean
WM or bulk
storage
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IDoc for Canceling Transfer Orders
Definition
Using IDoc WMCAID01, you can send a cancellation request to an external system, or
confirm execution of a cancellation movement to the Warehouse Management system
(WMS).

Use
When physical stock movements are executed via the connected external system, the WMS
cannot determine whether the TOs transferred to the external system have already been
executed. For this reason, the WMS can only send a cancellation request to the external
system.
The external system then decides whether or not the movement has already been executed.
If the stock movement has already been executed, the external system confirms to the WMS
that the stock movement has already been completed and that cancellation is therefore no
longer possible. In this case, the user receives a corresponding message in the WMS.
You decide for each individual case what should happen with a TO item that cannot be
cancelled. In this case, you make the necessary adjustments manually in the system.

You can only cancel these transfer orders (TOs) if they have not yet been
confirmed.

Sending a Cancellation Request from the WMS to the External System
To send a cancellation request from the WMS, fill the following fields in IDoc WMCAID01:

Segment

Field

E2LTCAH

LGNUM
TANUM
CANRQ

E2LTCAI

TAPOS
VLENR (if SU-management is active)
NLENR (if SU-management is active)

Sending a Cancellation from the External System to the WMS
To send a cancellation of a TO to the WMS, fill the following fields in IDoc WMCAID01:
Cancellation is possible

Segment

Field

E2LTCAH

LGNUM
TANUM
CANCL

E2LTCAI

TAPOS

Cancellation is not possible
Segment

Field

E2LTCAH

LGNUM
TANUM
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CANCL
E2LTCAI

TAPOS
SFEHL
SFTXT

You can also cancel a transfer order from the external system and send the
cancellation to the WMS, even if the WMS has not sent a cancellation request
first.

We recommend that you simulate sending a cancellation reply from the external
system to the WMS, in order to test the relevant cancellation processes. Reports
RLCATO00 and RLCATO10 are available for testing cancellation.

Structure
Message Type
You define message type WMCATO for the inbound and outbound partner profile.

Segments
IDoc WMCAID01 is made up of two segments:
•
•

E2LTCAH (TO header data)
E2LTCA (TO item data)

Segment definition E2LTCAH001 (as of release 4.0A)
Field

Data Type

Description

Required Entry

LGNUM

CHAR 3

Warehouse
number

X

TANUM

CHAR 10

Transfer order
number

X

CNAME

CHAR 12

User name for
TO cancellation

CANRQ

CHAR 1

Request
cancellation
transfer order

X

X for cancellation
request

CANCL

CHAR 1

Response
cancellation
transfer order

X

X for cancellation
from external
system

SOLEX

CHAR 15

Target
processing time
from external
system
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Segment definition E2LTCAI (as of release 3.0A)
Field

Data Type

Description

Required Entry

TAPOS

CHAR 4

Transfer order
item

X

VLENR

CHAR 20

Source storage
unit number

X

NLENR

CHAR 20

Destination
storage unit
number

X

SFEHL

CHAR 1

Error during
cancellation

SFTXT

CHAR 80

Error text for
cancellation

This text appears
in the inbox for
error messages

KZFOL

CHAR 1

Indicator:
Subsequent
actions

You can use this
field individually,
for example to
trigger a userdefined process
via a user exit.
You can, for
example, trigger
a user-defined
follow-up action
for differences.
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IDoc for Releasing Groups
Definition
Using IDoc WMRRID01, you can release transfer orders for a group [Extern] that have
already been send to an external system. The system sends the group number to the header
data of the transfer order to be created.

Use
Prerequisites
You have transferred the group number to the external system via IDoc WMTOID01 or
WMTOID02 for the TOs that have been grouped together.

Features
You group together the transfer orders so that you can execute the goods movements for
these TOs in one step (for example processing transfer orders for a certain shipping point or
removing stock in the same interim storage type). In this case, you cannot execute the goods
movement immediately after the external system receives the transfer order data. Using the
IDoc WMRRID01, you trigger the start of the stock movements for a certain group by
releasing the group.

Structure
Message Type
You define the outbound partner profile for message type WMRREF.

Segments
The IDoc is made up of segment E1LRRFX.

Segment definition E2LRRFX001 (as of release 4.0A)
Field

Data Type

Description

LGNUM

CHAR 3

Warehouse
number

REFNR

CHAR 10

Group

DATUM

CHAR 8

Date

UZEIT

CHAR 6

Time

L2KSR

CHAR 1

Relevance for 2step picking

LSKSO

CHAR 1

2-step picking:
Release
approval level
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IDoc for Blocking Storage Bins
Definition
Using IDoc WMBIID01, you can send individual storage bin data or comprehensive storage
bin data (for example all of the storage bins in one aisle) for blocking or unblocking from the
external system to the WMS.

We recommend that you simulate blocking and unblocking storage bins from the
external system to the WMS, in order to test the relevant processes. Report
RLBBIN00 is available for the test.

Use
When, for example, certain storage bins or aisles are not accessible for the external system
due to technical problems, you block these storage bins in the WMS so that they are not
considered during storage bin determination.
The external system initializes the block on the storage bins via IDoc WMBIID01. As soon as
the storage bins are available again, the external system triggers the unblocking of the
external system by the WMS via IDoc WMBIID01.

Structure
Message Type
You define message type WMBBIN for the inbound partner profile.

Segments
IDoc WMBIID01 is made up of the following segments:
•

•

E1BINH (Blocking storage bins IDoc header)
You determine whether blocking or unblocking storage bins is involved.
To block storage bins, set the indicator BLOCK.
To unblock storage bins, set the indicator DEBLO.
E1BINI (Blocking storage bins IDoc items)
TO block certain storage bins individually, transfer an E1LBINI segment for each
storage bin.

Segment definition E2LBINH (as of release 3.0A)
Field

Data Type

Description

Required
Entries

Note

LGNUM

CHAR 3

Warehouse
number

X

LGTYP

CHAR 3

Storage type

X

BLOCK

CHAR 1

Blocking storage
bins

X

Either BLOCK or
DEBLO

DEBLO

CHAR 1

Unblocking
storage bins

X

Either BLOCK or
DEBLO

Segment definition E2LBINI (as of release 3.0A)
Field

Data Type

Description

Required
Entries

Note

LGPLA

CHAR 10

Storage bin

X

Entry also
generic, for
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generic, for
example 01

SKZUA

CHAR 1

Block indicator:
For stock
removal

x

At least one of
the three
indicators

SKZUE

CHAR 1

Block indicator:
For putaway

x

At least one of
the three
indicators

SKZSI

CHAR 1

Blocking
indicator: Current
inventory

x

At least one of
the three
indicators

SPGRU

CHAR 1

Blocking reason

•
•

Set at least one of the three indicators.
To block a range of storage bins, use *. For example, enter 01* to block all storage bins,
which begin with 01.
You can only enter a blocking reason if the corresponding text is maintained in the
Customizing for Warehouse Management under Master Data → Storage Bins → Define
Blocking Reasons [Extern]
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IDoc for Creating and Canceling Transfer
Requirements
Definition
Using IDoc WMTRID01, you can send data on transfer requirements [Extern] from the
external system to the Warehouse Management system (WMS), so that the WMS can create
TRs on the basis of the data. You can also use the IDoc to cancel TRs that have already
been created in the WMS.

We recommend simulating construction and sending of the IDocs to the WMS in
order to test the relevant activities. Report RLTREQ00 is available for the test.

Use
Creating Transfer Requirements
Take the following into account when creating transfer requirements via IDoc WMTRID01:

Segment E1LTRQH (IDoc header data)
Field

Note

TBNUM

You do not transfer the TR number, since the
WMS issues the TR number

BETYP

You transfer this field if the movement type
used expects a requirement number, in order
to generate the link to the initiator of the stock
movement.

BENUM

You transfer this field if the movement type
used expects a requirement number, in order
to generate the link to the initiator of the stock
movement.

VLTYP

You use this field to define the source of the
stock movement.

VLPLA

You use this field to define the source of the
stock movement.

NLTYP

You use this field to define the destination of
the stock movement.

NLPLA

You use this field to define the destination of
the stock movement.

PDATU

You define when the TR should be converted
to a TO.

PZEIT

You define when the TR should be converted
to a TO.

LZNUM

To keep the TR clearly identifiable from the
point of view of the external system, the
external system assigns a reference number
and transfers this to the WMS.
You can only cancel TRs in the WMS from the
external system via a unique reference
number.
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This field is designed for customer
modifications in case confirmation of processed
TRs to the external system is required.

E1LTRQI (IDoc item data)
Field

Note

ABLAD

You define the destination of the goods
movement for individual items in the TR.

WEMPF

You define the destination of the goods
movement for individual items in the TR.

You generate a transfer
requirement (TR) in order to stage
several materials for a production
order within production. You define
the production storage type in the
transfer order header. However,
you define the work center where
the material is to be staged for
each individual TR item. You enter
the individual work centers in field
WEMPF.
WENUM

You use this field if you want to send
notification of a goods receipt or plan a goods
receipt with the TR.

WDATU

You use this field if you want to send
notification of a goods receipt or plan a goods
receipt with the TR.

Canceling Transfer Requirements
Take the following into account when canceling transfer requirements (TRs) via IDoc
WMTRID01:

E1LTRQH (IDoc header data)
Field

Note

LGNUM

Required entry

LZNUM

Required entry

E1LTRQI (IDoc item data)
Field

Note
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TBPOS

The external system does not transfer any TR
item numbers during creation of TRs in the
SAP system. The SAP system assigns the TR
item numbers on creation of the TR.
The system cancels TRs item by item. The
external system must therefore transfer the TR
item number of the TR item that is to be
cancelled. If the number is know in the external
system, the entire quant ID of a TR item must
be transferred to the SAP system with the
IDoc. In this case, you must fill fields MATNR,
BESTQ, CHARG, SOBKZ and LSONR.

ELIKZ

This indicator must be set if the TR item is to
be completely cancelled.
If you only want to cancel a partial quantity of
the item, transfer the quantity to be cancelled.
To increase the quantity of an item, transfer a
negative quantity for cancellation.
You transfer fields MENGE and MEINS.

Structure
Message Type
You define message type WMREQ for the inbound partner profile.

Segments
IDoc WMTRID01 is made up of two segments:
•
•

E1LTRQH (Transfer requirement, IDoc header data)
E1LTRQI (Transfer requirement, IDoc item data)

Segment definition E2LTRQH (as of release 3.0A)
Field

Data Type

Description

Required Entry

LGNUM

CHAR 3

Warehouse
number

X

TBNUM

CHAR 10

Transfer
requirement
number

TRART

CHAR 1

Transfer type

TBPRI

CHAR 1

Transfer priority

TBKTX

CHAR 40

Transfer
requirement
header text

BNAME

CHAR 12

User name

BETYP

CHAR 1

Requirement
type

BENUM

CHAR 10

Requirement
number

BWLVS

CHAR 3

Movement type
Warehouse
Management

VLTYP

CHAR 3

Source storage
type
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type

VLPLA

CHAR 10

Source storage
bin

NLTYP

CHAR 3

Destination
storage type

NLPLA

CHAR 10

Destination
storage bin

PDATU

CHAR 8

Date of planned
execution

PZEIT

CHAR 6

Time of planned
execution

LZNUM

CHAR 20

Additional
reference
number

TBRUE

CHAR 1

Indicator:
Confirm transfer
requirement

KTBAE

CHAR 1

Indicator: Cancel
transfer
requirement

X

On cancellation

X

On cancellation

Required Entry

Note

Segment definition E2LTRQI002 (as of release 4.6C)
Field

Data Type

Description

TBPOS

CHAR 4

Transfer
requirement item

MATNR

CHAR 18

Material number

X

WERKS

CHAR 4

Plant

X

BESTQ

CHAR 1

Stock category in
warehouse

X

If stock has
category

CHARG

CHAR 10

Batch number

X

If material is
subject to batch
management

SOBKZ

CHAR 1

Special stock
indicator

X

If special stock

LSONR

CHAR 24

Special stock
number

X

If special stock

MENGE

CHAR 15

Transfer
requirement
quanitity

X

MEINS

CHAR 3

Unit of measure

X

WEMPF

CHAR 12

Goods recipient

ABLAD

CHAR 25

Unloading point

WENUM

CHAR 10

Goods receipt
number

WDATU

CHAR 8

Goods receipt
date
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ZEUGN

CHAR 10

Certificate
number

ELIKZ

CHAR 1

Indicator: Final
delivery

VFDAT

CHAR 8

Shelf life
expiration date

LGORT

4 R

Storage location

L2SKR

1 R

Relevance for
two-step picking

MATNR_EXTER
NAL

CHAR 40

Long material
number (future
development) for
field MATNR

MATNR_VERSI
ON

CHAR 10

Version number
(future
development) for
field MATNR

MATNR_GUID

CHAR 32

External GUID
(future
development) for
field MATNR

X

If there is a
SLED
requirement

Can have value
‘2’ or ‘blank’

The external system may also have to transfer other data, as well as the required
entries. The extent of the IDoc data that is required depends on the type of
requirement (for example, putaway from production or staging for production) and
above all on the entries and settings in the WMS.
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IDoc for Stock Movements with Storage Units
Definition
Using IDoc WMSUID01, you report stock movements of storage units (SUs), for example
stock transfers, from the external system to the WMS.

We recommend simulating construction and transmission of the IDocs to the
WMS in order to test the relevant activities. Report RLSUMO00 is available for
the test.

Use
Prerequisite
You have already created the SU that you want to move in the external system in the WMS.
The data on the SU is available in the WMS.

Features
When you trigger a stock transfer of SUs in the external system, or when the external system
determines the final storage bin for a SU in a high rack storage area for putaway of the SU,
the external system reports the stock movement data to the WMS.
In certain cases, it is necessary to trigger a stock transfer of storage units in the external
system. For putaway of a pallet, it can also make sense for the external system to assign the
final storage bin for the material in a high rack storage area. The external system must report
the executed movement of a SU to the WMS. The WMS subsequently posts the reported SU
movement in the system.
Using IDoc WMSSUID01, you can also transfer the external target processing time for the
stock movement to the WMS.

Putaway Using an Identification (ID) Point
If you putaway the SU using an ID point, you can call function module L_SU_MOVE_LSR
synchronously in the WMS in place of IDoc WMSUID01. In doing so, you avoid inadvertent
double posting in the WMS.
1. The WMS reports the transfer order for putaway at the ID point to the external system
and prints the pallet note.
2. The external system identifies the pallet and executes the contour control.
3. The external system changes the SU type of the pallet according to the contour control,
and may also define the destination storage bin of the pallet in high rack storage.
4. The external system calls function module L_SU_MOVE_LSR.
a. The WMS reports the destination storage bin of the pallet to the external system if the
WMS is the dominant system.
b. The external system transfers the destination storage bin in the high rack storage
area to the WMS if the WMS is the dominant system and waits for successful posting
of the destination storage bin in the WMS.
If the SU has already been putaway from the ID point, the function module reads the
corresponding destination storage bin and reports this to the WMS.

Structure
Message Type
You define message type WMSUMO for the inbound partner profile.

Segments
The IDoc consists of segment E1LSUMX with the following fields:

Segment definition E2LSUMX001 (Move storage unit IDoc segment) as of release 4.0A
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Field

Data Type

Description

Required Entry

LGNUM

CHAR 3

Warehouse
number

X

LENUM

CHAR 20

Storage unit
number

X

BWLVS

CHAR 3

Movement type
Warehouse
Management

X

LETYP

CHAR 3

Storage unit type

You do not
always have to
transfer this field

LZNUM

CHAR 20

Additional
reference
number

You use this field
for transfer of a
transfer order

BNAME

CHAR 12

User name

KZQUI

CHAR 1

Indicator:
Confirmation
required

Normally you do
not set this field
since the stock
movement that is
transferred has
usually already
been executed
and therefore no
longer requires
confirmation.

VLTYP

CHAR 3

Source storage
type

Is available in the
WMS

VLBER

CHAR 3

Source storage
area

Is available in the
WMS

VLPLA

CHAR 10

Source storage
bin

Is available in the
WMS

VPPOS

CHAR 2

Item in source
storage bin

NLTYP

CHAR 3

Destination
storage type

NLBER

CHAR 3

Destination
storage area

NLPLA

CHAR 10

Destination
storage bin

NPPOS

CHAR 2

Item in source
storage bin

You only use this
field with
putaway strategy
P. The field gives
the exact
position of the
SU in the shelf
section.

STATU

CHAR 1

Status of storage
unit

Not used for
transferring from
the external
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system to the
WMS

REFNR

CHAR 10

Group

PERNR

8 R

TO processor
(personnel
number)

SOLEX

15 R

Target
processing time
from external
system
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IDoc for Inventory
Definition
Using IDoc WMIVID01, you send inventory documents from the WMS to the external system
and report the count results from the external system to the WMS.

We recommend testing the transfer of inventory data between the WMS and the
external system. Report RLINVE00 is available for the test. In doing so, the WMS
simulates data entry via a mobile data entry device.
The WMS takes data from existing inventory documents in order to simulate the
receipt of IDoc WMIVID01.

Note that during a test in a productive system, the WMS does actually posts a
document.

Use
Sending the Physical Inventory Document
To send physical inventory documents from the WMS to an external system, choose Logistics
→ Logistics Execution → Internal Whse Processes → Physical Inventory → In Warehouse
Management → Physical Inventory Document → Print Warehouse Inventory List.
To send physical inventory documents, use report RLLI0405. Enter the receiving system and
select send.

You can print the physical inventory documents parallel to transmission.
The WMS updates the data, both on sending and on printing the physical inventory
documents. If you send or print the physical inventory documents again, the system indicates
that this has been done before.

Receiving the Inventory Count Results
You also use IDoc WMIVID01 to report inventory count results to the WMS. In doing so, you
send one E1LINVX segment for each quant counted.
The sequence in which the WMS receives the IDoc segment is not relevant for the inventory
count results. You can therefore send an IDoc with a number of E1LINVX segments. The
posting sequence in the WMS is irrelevant.

Structure
Message Type
You define the outbound partner profile for message type WMINVE for sending the physical
inventory documents to the external system.
For reporting the count results from the external system, you define the inbound partner
profile for message type WMINVE.

Segments
IDoc WMIVID01 consists of segment E1LINVX with the following fields:

Segment definition E2LINVX003 (as of release 4.6C)
Field

Data Type

Description

Required Entry

LGNUM

CHAR 3

Warehouse
number

X

IVNUM

CHAR 10

Physical
inventory
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inventory
document
number

IVPOS

CHAR 4

Inventory item

LGTYP

CHAR 3

Storage type

X

LGPLA

CHAR 10

Storage bin

X

PLPOS

CHAR 2

Position in
storage bin

X

MATNR

CHAR 18

Material number

X

WERKS

CHAR 4

Plant

X

CHARG

CHAR 10

Batch number

X

If working with
batches

SOBKZ

CHAR 1

Special stock
indicator

X

If special stock

LSONR

CHAR 24

Special stock
number

X

If special stock

BESTQ

CHAR 1

Stock category in
warehouse

X

If stock in quality
inspection

WDATU

CHAR 8

Goods receipt
date

LENUM

CHAR 20

Storage unit
number

X

If SU-managed
storage type

MENGA

CHAR 15

Quantity for
count results

X

Either here or
quantity 0
KZNUL

ALTME

CHAR 3

Unit of measure

X

LQNUM

CHAR 10

Quant number

NANUM

CHAR 2

Inventory recount
number

NVERS

CHAR 2

Recount version

ISTAT

CHAR 1

Inventory item
status

IDATU

CHAR 8

Date of Inventory

KZINV

CHAR 2

Inventory method

IRNUM

CHAR 10

Inventory
reference
number

MAKTX

CHAR 40

Material
description

ISEIT

CHAR 4

Inventory side

LETYP

CHAR 3

Storage unit type

KZNUL

CHAR 1

Indicator: Bin
empty

Interface Between the WMS and External Systems

If putaway
strategy P in
storage type

Either here or
quantity MENGA

620

66

SAP Online Help

07.10.2002

VFDAT

CHAR 8

Shelf life
expiration date

LGORT

4 R

Storage location

UNAME

CHAR 25

Name of counter

MATNR_EXTER
NAL

CHAR 40

Long material
number (future
development) for
field MATNR

MATNR_VERSI
ON

CHAR 10

Long version
number (future
development) for
field MATNR

MATNR_GUID

CHAR 32

External GUID
(future
development) for
field MATNR
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IDoc for Transferring Information Texts
Definition
Using IDoc WMINID01, you can send information texts from the external system to the WMS.

We recommend simulating construction and transmission of the IDocs in order to
test the relevant activities. Report RLINFO00 is available for the test.

Use
The WMS transfers the information texts from the external system as messages to the inbox
of the user, who is assigned to the respective position. For more information, see IDoc Error
Processing [Seite 69].

Structure
Message Type
You define message type WMINFO for the inbound partner profile.

Segments
IDoc WMINID01 consists of segment E1LINVX with the following fields:

Segment definition E2LINFX (as of release 3.0A)
Field

Data Type

Description

Required Entry

LGNUM

CHAR 3

Warehouse
number

X

ITEXT

CHAR 80

Information text
for linkage

X

DATUM

CHAR 8

Date

UZEIT

CHAR 6

Time

Interface Between the WMS and External Systems

Note

620

68

SAP Online Help

07.10.2002

IDoc Error Processing
TCP/IP Errors
The basis for IDoc transfer between the systems is TCP/IP [Extern]. If an error occurs during
the transfer, the connection between the sending system and the receiving system is
interrupted.
Based on return codes in the RFC function used, you can see in the sending system whether
an RFC call has worked. If there are TCP/IP errors, break the connection and send the IDoc
again.

Technical Errors
Errors which occur in the ALE service layer on sending or receiving IDocs are technical
errors.
If a technical error occurs, the SAP WMS sends a workflow work item for each IDoc
containing errors. This is an error message, which the system sends to all users responsible.
Based on the error message, the user can analyze the error and post the document
subsequently. For more information, see Processing Technical IDoc Errors [Seite 73].

Logical Errors
The system saves a received IDoc in the database before the IDoc has actually been
processed. The system breaks off communication with the external system before the
transferred data is then processed.
If an error occurs in the application system (the Warehouse Management system) during
processing of an IDoc, then it is a logical error. In this case, the SAP WMS creates a workflow
work item for every IDoc containing errors.
For more information, see Processing Logical IDoc Errors in the WMS [Seite 76].
See also:
Exception Handling [Extern]
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Activating IDoc Error Processing
Use
If an error occurs during processing of an IDoc in the Warehouse Management system
(WMS), the system sends an error message to the assigned user.

Prerequisites
For more information on the prerequisites, see Rule Resolution in Exception Handling
[Extern].

Features
To assign error messages to the corresponding user, assign a standard task [Extern] for each
message type in a position. One or more users are assigned to the position.
For more information, see Interfaces → External systems → Configure Warehouse
Management [Extern] → Error Handing → Org.units and standard tasks in the implementation
guide (IMG) for Warehouse Mangement.
There are three options:
• You enter the organizational unit generally in the partner definition and make no further
entries in the actual partner profile for each message type.
In this case, the messages go to all of the users who are assigned to the
organizational unit and who have the standard task in question assigned to their
position.
•

You do not enter the organizational unit in the partner profile: You enter a specific
position.

•

You override the entry in the partner definition with entries in the partner profile for a
message type.

We recommend entering the organizational unit overall in the partner profile.
If, however, you connect two external systems to the WMS and want to assign
different users to each system, you should separate the error messages through
different partner positions.

Assigning Error Messages
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Partner
PartnerDefinition
Definitionfor
forSpecific
Specific
Partner
PartnerNumber
Numberand
andLogistical
LogisticalSystem
System

Organisational
Organisational Unit
Unit

Message
MessageRecipient…
Recipient…
Type
Type
Lang.
Lang.
ID
ID

OO
Organisational
OrganisationalUnit
Unit
EE
English
English
50005004
50005004 WM
WMTeam
Team

Location
Location

Location
Location

User
User

Partner
PartnerProfile
Profilefor
for
Specific
SpecificMessage
MessageTypes
Types

Error
Error
Error
Error
Error
Error
...
...

Message
MessageRecipient
Recipient…
…
Type
Type
Lang.
Lang.
ID
ID

__
__
___
___
__________
__________

...

Cancel
Cancel TO
TO
Inventory
Inventory Count
Count Data
Data
Confirm
Confirm TO
TO

It is not enough to enter user names directly into the partner definition or the
partner profile because the system cannot assign the standard tasks in this case.

Activities
1. You define an organizational unit. You can assign the organizational unit to several
different positions.
2. You define a position.
3. You assign the users to the position.
4. You assign the users a standard task.

Standard Tasks
Area

Description

IDoc processing (technical errors)

Outbound, Error message with IDoc
Inbound, Error message with IDoc
Outbound, syntax error in IDoc
Inbound, syntax error in IDoc

Application errors (logical errors)

Error, TO cancellation
Error, inventory count data
Error, TO confirmation
Error, goods movement
Error, transfer orders
Error, moving storage unit
Error, blocking storage bins
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Error, user-defined message
Error, transfer requirement
Error, Pick HU creation
Information
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Processing Technical IDoc Errors
Use
During communication between the external system and the Warehouse Management system
(WMS), technical problems can occur in the ALE layer. The following errors can occur:
•
•
•
•

Syntax error in the IDoc
Missing partner profile
The IDoc was not transferred to a synchronous Remote Function Call on transmission
The IDoc was not transferred to the application on receipt

Error During Outbound IDoc Processing
IDoc status 07: Syntax error in IDoc
On sending and receiving IDocs, the system checks the syntax of the individual IDocs. The
IDoc definition defines the syntax of the IDoc. The syntax includes:
• The individual segments of an IDoc type
• The relationship between the individual segments
• How many segments can be sent in one IDoc
Normally, incorrect syntax in IDocs only occurs in testing. IDocs with incorrect syntax cannot
be repaired. You correct the IDoc structure in the SAP system and send the IDoc again.

We recommend only switching on the syntax check during testing of IDocs
created yourself. You activate the syntax check via the partner profile for one
IDoc type and a one particular partner.

IDoc status 29: Missing or incorrect partner profile
To send an IDoc from the SAP system to the external system, you must define outbound
parameters for the message type and all relevant partners.
For more information, see Interfaces → External Systems → Configure Warehouse
Management [Extern] → Communication R/3 -> External System → Maintain Partner Profile
in the Implementation Guide for Warehouse Management.
If the system cannot find the partner (that is, the connected partner system) for sending the
IDocs, proceed as follows:
•
•

Define the missing partner profile.
Resend all existing IDocs, which the system has not yet been able to send.
For this error, the system triggers a workflow work item for the standard task Output:
Error processing with IDoc and sends a message to the inbox of the corresponding
user.
You trigger subsequent sending of the IDocs that contained errors from the inbox.
On subsequent transmission, the incorrect IDoc is flagged with status 31 and copied
to a new IDoc, which is enhanced with data from the partner profile and transferred to
the asynchronous RFC.

Errors in partner profiles normally only occur in the test run.

IDoc status 30: The IDoc is not transferred to the asynchronous RFC
Although the partner profile is defined and the IDoc has been constructed, the IDoc cannot be
transferred to the asynchronous RFC. The IDoc is not sent, and there is no official entry in the
RFC valuation (/nSM58) for the relevant subsystem.
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You trigger transmission of the IDoc using report RSEOUT00. To start the report manually,
choose Tools → Business Communication → IDoc Basis → Test → Outbound Processing
from IDoc (/nWE14), or schedule a regular job in background processing for this report.
Check the outbound processing mode for the IDoc in the partner profile.
• Outbound processing mode 2: The system sends the IDoc immediately
• Outbound processing mode 4: The system collects IDocs that have been created and
sends them in packets of a predefined size.
IDocs are not intended to be sent directly.
Status 30 in the IDoc can normally only occur if outbound mode is set to 4.

Error During Outbound IDoc Processing
IDoc status 60: Syntax error in IDoc
On sending and receiving IDocs, the system checks the syntax of the individual IDocs. The
IDoc definition defines the syntax of the IDoc. The syntax includes:
• The individual segments of an IDoc type
• The relationship between the individual segments
• How many segments can be sent in one IDoc
Normally, incorrect syntax in IDocs only occurs in testing. IDocs with incorrect syntax cannot
be repaired. You correct the IDoc structure in the SAP system and send the IDoc again.

You activate the syntax check via the partner profile for one IDoc type and one
particular partner. We recommend that you activate the syntax check, particularly
for any IDocs that you have created yourself.

IDoc status 63: Missing or incorrect partner profile
To receive an IDoc in the SAP system from the external system, you must define the
outbound partner profile for the message type and all relevant partners.
For more information, see Interfaces → External Systems → Configure Warehouse
Management [Extern] → Communication Ext. System -> R/3 → Maintain Partner Profile in the
Implementation Guide for Warehouse Management.
If the system cannot find the partner (that is, the connected partner system) for receiving the
IDocs, proceed as follows:
• Define the missing partner profile.
• Trigger receipt of all existing IDocs, which the system has not yet been able to process,
again.
For this error, the system triggers a workflow work item for the standard task Input:
Error processing with IDoc and sends a message to the inbox of the corresponding
user.
From the inbox, you trigger the subsequent transmission of the IDocs which
contained errors.
Errors in partner profiles normally only occur in the test run.

IDoc status 64: IDoc is not transferred to the application
Although the partner profile is defined and the IDoc has been received, the IDoc cannot be
transferred to the application.
You trigger transmission of the IDoc using report RBDAPP01. To do this, plan a regular job in
background processing for this report.
Check the processing mode for the IDoc in the partner profile:
• Processing mode 1: The system transmits the IDoc immediately after receipt in the
application.
• Output mode 3: The system collects received IDocs.
IDocs are not intended to be transmitted directly to the application.
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Status 64 in the IDoc can normally only occur in conjunction with processing mode 3 and
output mode 2.
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Processing Logical IDoc Errors in the WMS
When you receive an IDoc in the SAP system from the external system, the following errors
can occur in the Warehouse Management system (WMS):
•

Missing or incorrect Customizing settings in the WMS

•
•

Missing or incorrect data in the IDoc
Error due to blocked objects

Logical IDoc errors do not occur during outbound IDoc processing from the SAP
system, because the missing or incorrect Customizing settings in the WMS cause
an error before this can occur.
The system flags the incorrect IDocs with status 51.

Missing or Incorrect Customizing Settings
Cause
The SAP system cannot process the received IDoc further if:
• Certain data from the IDoc is not defined in the SAP system

•

In the IDoc, you transfer a stock movement from the external system with a
movement type that the SAP system does not recognize.
The received IDoc data does not correspond to the Customizing settings in the SAP
system.

The stock movement reported by the external system is defined for immediate
confirmation. However, the movement type in the WMS does not allow immediate
confirmation for this stock movement.

Procedure
1. You correct the relevant Customizing settings.
2. You subsequently post the incorrect IDoc
Either from the inbox of the assigned user
Or via report RBDMANIN, which you schedule periodically in background processing.

Missing or Incorrect IDoc Data
If the data in the received IDoc is incomplete, you must decide whether the incorrect IDoc
should be transmitted again or whether it is possible or appropriate to carry out corrections in
the SAP system:
•

You can make the corrections to the IDoc using the IDoc editor.

•

Only correct the IDoc using the IDoc editor in exceptional cases.
You can subsequently post IDocs of the type WMIVID01 on reporting physical inventory
data and correct the data in the relevant transaction.

Procedure
You subsequently post the incorrect IDoc
−
−

Either from the inbox of the assigned user
Or via report RBDMANIN, which you schedule periodically in background processing.
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Error Due to Blocked Objects
If blocking problems occur in the SAP system, IDoc processing leads to an error.

If there are concurrent attempts (by different users) to access the same SAP
object, the system terminates processing, with an error note for the blocked
object.

Procedure
You do not need to intervene manually. Schedule report RBDMANIN for periodical
background processing.
Using the parameter error status, you can define in the report that IDocs with the error
message for a blocking error should be automatically subsequently posted.

Important Error Notes in Inbox
For the errors listed above, the system creates a workflow work item in the inbox of the
person responsible. For more information, see Rule Resolution in Exception Handling
[Extern].
Workflow work items are also suitable for important notes,
•
•

Which the external system sends to the SAP system
Which are created during IDoc processing in the Warehouse Management system
(WMS).
These workflow work items
• Inform the user about a problem or a conflict situation
•

Send on important messages from the external system to the SAP system.
The external system transmits the messages via message type WMINFO.

The external system triggers an internal message if a transfer order or a storage
unit can no longer be confirmed because confirmation has already taken place.
Someone has to be informed of this situation since this confirmation can usually
only be carried out by the external system.
You do not process workflow work items for notes from the inbox as you do for errors, but
rather complete the workflow work item.
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Modification Possibilities
Use
The interface between the Warehouse Management system (WMS) and the external system
(WMS-WCU interface) offers the following possibilities for customer modification at the
interface:
• Modifying inbound IDoc processing [Seite 79]
• Modifying outbound IDoc processing [Seite 82]
Several customer exits [Seite 84] are also available at this point for adjusting and enhancing
interface processing to suit individual needs.
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Modification Concepts: IDoc Inbound Processing
Use
The following modification scenarios are available to you:
•

•

You use the standard IDoc but want to define the processing yourself.
You create a user-defined processing module, which you copy from the standard
function module for the respective message type and adjust accordingly.
You use the standard IDoc but want to adjust the standard IDoc processing. That is to
say, you want to modify error processing or want to interpret the contents of the IDocs to
suit your individual needs.
You activate the customer exits in the standard function module:
− If you want to influence error processing, you activate the customer exit for Own error
status.
−

If you want to influence IDoc processing, you activate the customer exit for Own
updates.

•

You use a modified IDoc with user-defined segments and want to execute a particular
process for the data from these segments.
You define your own IDoc segments in the standard IDoc and use the customer exit
for Own update to process the data from the user-defined segments.

•

You use a modified IDoc with customized segments and want to define IDoc processing
yourself.
You define customized IDoc segments in the standard IDoc and create a customized
processing function module.

•

You use a user-defined IDoc with a new message type and have to implement processing
of the IDoc on your own.
You define a user-defined IDoc and create a user-defined processing function
module. You can use the standard auxiliary function module to create the function
module.

Features
Adjusting the Standard Function Module
As soon as the SAP system has received the IDoc and saved it, the system calls a main
function module of the application, which takes over the processing of the IDoc.
At this point, you have the first opportunity to intervene in the IDoc processing, by creating a
user-defined function module.
You enter this function module in the SAP menu under Tools → Business Communication →
IDoc-Basis → Development → Inbound Processing Settings → Message/Application
Object.
There, you can also enter an additional partner profile for a certain message variant or
message function from the external system in order to differentiate processing in the SAP
system.

Main function modules for inbound IDoc processing
Message Type

Function module

Use

WMBBIN

L_IDOC_INPUT_WMBBIN

Blocking storage bin

WMCATO

L_IDOC_INPUT_WMCATO

Canceling TO

WMINFO

L_IDOC_INPUT_WMINFO

Information

WMINVE

L_IDOC_INPUT_WMINVE

System inventory records

WMMBXY

L_IDOC_INPUT_WMMBXY

Goods movements
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WMSUMO

L_IDOC_INPUT_WMSUMO

Moving a storage unit

WMTOCO

L_IDOC_INPUT_WMTOCO

Confirming TO

WMTORD

L_IDOC_INPUT_WMTORD_
MULTIPLE

Transfer orders (TO)

WMTREQ

L_IDOC_INPUT_WMTREQ

Releasing group

The main function module filters out the data for each IDoc and calls the actual processing
function module of the application in a loop.

Activating Customer Exits
A customer exit is implemented both before and after the call of this function module.
• You can use the customer exit after the function module call to update a user-defined
error status or to change the set error status.
•

You can use the customer exit before the call of the function module, for example to
execute user-defined updates or to valuate user-defined segments, which you have
added in the IDoc definition.

Take the names of the customer exits from the source code of the main function
module.
If you create a function module or use customer exits, note that no COMMIT WORK
command is set, as this can lead to errors in IDoc processing and to inconsistencies in error
processing. The system returns to the ALE layer following processing, where the system
updates any application errors that have occured, sets the IDoc status, and may even
execute database rollbacks.

Note, that additional I/Os which occur in the customer exit, can affect
performance.

Defining User-Defined IDoc Segments
You defined your own IDoc segments by choosing Tools → Business Communication → IDoc
Basis → Development → IDoc Types. For more information, see Segment Editor [Extern].

Creating User-Defined Processing Function Modules
The SAP system offers function modules for general use for the following tasks for using
user-defined main function modules:

Auxiliary function modules for inbound IDoc processing
Function module

Task

L_IDOC_CONTINUE_SAVE

Continuously save application objects for
subsequent activities

L_IDOC_CREATED_OBJECTS_SAVE

Continuously save the documents created from
an IDoc

L_IDOC_ERROR_SAVE

Continuously save IDocs with errors

L_IDOC_INPUT_REFRESH

Initialization for IDoc processing (table refresh)

L_IDOC_OK_SAVE

Continuously save processed IDocs

L_IDOC_RETURN_CREATE

Determine and construct status record for the
IDoc

L_IDOC_ROLLBACK_SAVE

Update IDoc tables after necessary rollback

L_IDOC_STATUS_CREATE

Determine and construct status record for the
IDoc
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Fetch internal table for the purpose of status
update

Defining User-Defined IDocs
If you define user-defined IDocs (interim structure) via Tools → Business Communication →
IDoc Basis → Development → IDoc Types, assign this IDoc to a new message type. For
more information, see Defining New IDoc Types [Extern].
You create a partner profile for this message type.
You define the tables for inbound processing for this IDoc under Tools → ALE → ALE
Development → IDoc → Inbound Processing.
Standard task TS00008099 is available for error processing.
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Modification Concepts: IDoc Outbound
Processing
Use
The following modification scenarios are available:
• You use the standard IDoc but want to influence the construction of the IDoc.
You create a user-defined processing module, which you copy from the standard
function module for the respective message type and adjust accordingly.
You activate the user-exit in the standard function module in order to influence the
standard IDoc construction.
• You use the standard IDoc but want to define when and to whom a transfer order item
should be sent yourself. In this case, you do not use the standard flow of the interface.
You implement your own interface connection between the Warehouse Management
system (WMS) and the external system.
•

•

•

•

•

You use a modified IDoc with user-defined segments and you want to trigger user-defined
processing to construct the data in the segments.
You define your own IDoc segments in the standard IDoc and use the user exit fill
your user-defined segments with data.
You use a modified IDoc with user-defined segments and want to implement IDoc
construction yourself.
You define your own IDoc segments in the standard IDoc and create your own
processing function module, which you copy from the standard function module of the
relevant message type and adjust accordingly.
You use a modified IDoc with user-defined segments and do not want to use the standard
flow of the interface.
You define your own IDoc segments in the standard IDoc and implement an
individually defined interface connection between the WMS and the external system.
You use an individually defined IDoc with a new message type and have to implement
IDoc construction yourself.
You define an individual IDoc and create an individually defined function module.
Standard auxiliary function modules are available for this purpose.
You use a modified IDoc with a new message type and do not want to use the standard
flow of the interface.
You define an individual IDoc and implement an individually defined interface
connection between the WMS and the external system.

Features
Adjusting the Standard Function Module
The WMS prepares for the IDoc to be sent to the external system. The system constructs the
IDoc in the relevant application function module, determines the partner (the connected
system), and steers towards the ALE layer for further processing.
At this point, you have the first opportunity to intervene in the IDoc processing, by creating a
customized function module.
You enter this function module in the Customizing for Warehouse Management under
Interfaces → External Systems → Configure Warehouse Management [Extern] → Whse
Management View → R/3 -> External System → Function Modules for IDoc Creation →
Assign.
The WMS uses the following function modules for constructing and sending IDocs:

Function modules for outbound IDoc processing
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Function module

Description

L_IDOC_CREATE_WMTOID01

Transfer orders

L_IDOC_CREATE_WMRRID01

Group release

L_IDOC_CREATE_WMCAID01

Cancellation request TO

L_IDOC_CREATE_WMIVID01

System inventory records

User exits are available in the function modules for adding individually-defined
segments or influencing the standard IDoc construction.

Realizing an Individually Defined Interface Connection
You realize an individually defined interface connection in order to be able to decide yourself
when communication with the external system should occur and to which external system the
data should be sent.

In this case, the interface in the WMS should not be active.
You use the user exit Enhancement at End of TO Creation (MWMTO01) to implement an
individually defined connection between the systems.

Defining User-Defined IDoc Segments
You define your own IDoc segments by choosing Tools → Business Communication → IDoc
Basis → Development → IDoc Types. For more information, see Segment Editor [Extern].

Defining User-Defined IDocs
If you define user-defined IDocs (interim structure) via Tools → Business Communication →
IDoc Basis → Development → IDoc Types, assign this IDoc to a new message type. For
more information, see Defining New IDoc Types [Extern].
You create a partner profile for this message type.

Creating Individually Defined Send Function Modules
For creating individual send function modules, SAP provides the following function modules,
which are already used in SAP send function modules.

Modification Concepts: IDoc Outbound Processing
Function module

Task

L_IDOC_HEADER_CREATE

Construction of the necessary EDIDC data per
IDoc

L_IDOC_SEGMENT_CREATE

Construction of an IDoc segment

L_IDOC_SEND

Sending the constructed IDoc

L_IDOC_FETCH

For access to the data in your program after
calling your IDOC_CREATE_....
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Interface Customer Exits
The Warehouse Management system (WMS) offers the following customer exits:

Enhancements to the WMS-WCU interface
Enhancements

Description

MWMIDI01

Error processing for IDoc inbound processing
for IDocs WMTOCO, WMCATO, WMBBIN,
WNTREQ, WMSUMO collectively

MWMIDI02

Message WMTOCO (TO confirmation) inbound

MWMIDI03

Message WMCATO (TO cancellation) inbound

MWMIDI04

Message WMBBIN (block storage bin) inbound

MWMIDI05

Message WMTREQ (TR creation) inbound

MWMIDI06

Message WMSUMO (Move storage unit)
inbound

MWMIDI07

Message WMPIHU (pick HU creation) inbound

MWMIDO01

IDoc WMTOID01 (transfer order) outbound

MWMIDO02

IDoc WMCAID01 (TO cancellation request)
outbound

MWMIDO03

IDocs WMRRID01 (release group) outbound

MWMIDO04

IDoc WMIVID01 (system inventory record)
outbound

MWMIDO07

Error processing for IDoc inbound processing:
Mobile data entry for IDocs WMMBXY,
WMINVE, WMTORD collectively

MWMIDO08

Message WMMBXY (goods movement)
inbound

MWMIDO09

Message WMINVE (inventory count data)
inbound

MWMIDO10

Message WMTORD (TO creation) inbound

MWMIDO11

Message WMTORD: TO with several items

MWMIDO12

Message WMPIHU (pick HUs) outbound

MWMIDO13

Message WMMBXY: Follow-up action after
goods posting
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